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 Welcome to the latest issue of Macworld. 
This month we’re looking forward to 
WWDC. A highlight of Apple’s yearly 

calendar, the annual get‑together for the company’s 
software partners always sees it unveil a range of 
new products. This time around we’re expecting 
new versions of its operating systems, updates to 
Siri and Apple Music, and potentially new laptops. 
Read our preview on page 4. 

Last year, we were bowled over by the latest 
addition to the company’s range of laptops – the 
gorgeous‑looking MacBook. Some critics, however, 
claimed it was a case of style over substance 
and that its performance was a disappointment – 
something we disagreed with. In an attempt to tackle 
this perception, Apple has released a new version 
with improved specs. Read our review on page 15.

Most of us think of the Apple TV as a great 
device for streaming movies and watching catch‑up 
television. However, Apple’s media player has 
another string to its bow – it’s a fantastic mini 
games console. On page 85, we round up the 
best games you can get, and unlike PlayStation 
or Xbox titles they won’t cost you the earth. 

Plus, we’ve 39 pages of tips and tutorials, so 
you can get the most out of your Apple hardware.

We hope you’ve enjoyed the issue. Send us 
your feedback via facebook.com/MacworldUK. 

Welcome... 
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 WWDC, or the Worldwide Developers’ 
Conference, is a highlight of Apple’s 
yearly calendar. Due to run from 13 to 17 

June, the annual get‑together for the company’s 
software partners (not to mention representatives of 
the world’s media) always sees Apple unveil a range 
of new products. This year we’re expecting the latest 
versions of its operating systems, updates to Siri 
and Apple Music, and potentially new laptops.

Lewis Painter reveals what we can expect at WWDC 2016

News:  
WWDC 2016 preview
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Apple Music
According to Bloomberg, one of Apple’s focuses 
at WWDC 2016 will be its music‑streaming service, 
Apple Music, which launched at WWDC 2015 and 
has received mixed reviews ever since.

As we approach its first anniversary, most analysts 
would agree it has been a qualified success. Apple 
has established a solid subscriber base, passing 
10 million paying users earlier this year, and its 
small but growing Services revenue, the non‑
itemised section of its earnings that includes Apple 
Music as well as the App Store and other paid‑for 
software products, was one of the few highlights 
of its Q2 2016 report. Yet complaints remain about 
the service’s interface and sometimes sketchy 
integration with users’ personal music libraries, 
and Spotify continues to prosper and grow. 

Bloomberg, citing “people familiar with the 
product who asked not to be identified because 
the plans aren’t public”, predicts that WWDC 2016 
will see Apple unveil an updated and more intuitive 
user interface for Apple Music, and announce plans 
to improve integration between the company’s 
streaming and download businesses. 

9to5Mac, a reliable source of pre‑release Apple 
leaks, offers more detail about the updated version 
of Apple Music. The current interface is visually 
busy, with translucency effects and a colour scheme 
that changes to match the album artwork. The new 
interface will retain the artwork – indeed, this will be 
given ‘huge’ prominence, in a look that a source calls 
“bolder, yet simpler” – but the rest of the interface 
will be graphically stripped back and remain black 
and white regardless of the album. Menu text will be 
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larger and bolder, in a style that is reportedly more 
appropriate to Apple’s San Francisco font, which 
itself will be rolled out to a wider array of services 
and products this summer.

There will be new features, too: 3D Touch 
shortcuts; automatically integrated lyrics; and the 
New tab will be replaced by a better‑organised 
section called Browse.

It’s also been reported that Apple is planning to 
expand its online radio service and commence a 
high‑profile marketing campaign to bring in more 
paying users to the Apple Music service. 

Siri
Apple’s WWDC 2016 announcement has convinced 
us that Siri is about to get a big update. Asking it 
“When is WWDC?” resulted in the answer below.

The invite itself is themed around the Swift 
coding language used in iOS apps (see page 4), 
and references popular apps including Snapchat, 
Tinder, Crossy Road, Instagram and more, so 
there’s not much to be garnered there as it is a 
developers conference after all.
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But it does make us think that Siri and third‑party 
apps are about to get a lot more friendly. Siri could 
be about to open up to developers, who’ll be able 
to integrate the voice assistant into their apps for 
iOS and watchOS to take things to the next level.

Siri could also be on its way to Mac if rumours 
are to be believed. (See page 10 for further details.)

iOS 10
Apple historically announces the next generation 
of iOS software at its WWDC events in June, and 
this year doesn’t look to be any different, although 
some rumours suggest otherwise.

Our colleagues at Macworld US, for example, 
believe that iOS 9 is the first in a new iOS life cycle 
at Apple, with the company concentrating on more 
important ‘point’ updates rather than a completely 
new version of iOS. iOS 9.3 is a good example of 
this – iOS 9.3 came with a number of new features 
including Night Shift mode (see page 61), which 
many believe is more of a ‘flagship’ software 
feature that should be announced with a completely 
new iOS update. iOS 9.3 also went through a 
rigorous public beta testing period too, something 
(generally) exclusive to new iterations of Apple’s 
mobile operating system.

However, if they aren’t correct (sorry guys) then 
what could we see from iOS 10? One key feature 
of the software, according to current rumours, 
is that users will finally have the option to hide 
unwanted preinstalled apps. That means you can 
wave goodbye to default apps such as Stocks 
and Compass, two apps that we can honestly say 
we’ve never used on our iPhones. Other significant 
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software rumours include iCloud Voicemail where 
Siri handles all unwanted calls, and possibly some 
kind of ‘Contact availability status’ where your 
phone will tell you if your contact is available to 
speak at that time.

OS X 10.12 (Fuji)
As well as announcing the latest iteration of iOS 
at WWDC events, Apple also showcases the latest 
version of its Mac OS X software, this year named 
‘Fuji’ (according to reports anyway). Apple usually 
announces the software in June, then releases it 
in the autumn after thorough beta testing, usually 
around September or October. What do we expect 
from Fuji? Current rumours suggest that Siri will 
finally make an appearance on the Mac operating 
system in a bid to compete with OS‑baked virtual 
assistants such as Cortana in Windows 10. The 
report claims that Apple has been testing the 
feature internally for three years, and it’s now 
finally ready to be rolled out to the public.

Other rumours suggest that Apple may rename 
the ‘Mac OS X’ operating system to ‘macOS’, 
bringing the Mac operating system branding 
in line with Apple’s general operating system 
branding – iOS, tvOS and watchOS. 

New Mac laptops
Here is where things get a little bit confusing. 
Apple usually updates its Mac laptop range around 
this time of year, and while Apple has released 
an update to the 12in MacBook (read our review 
on page 15), the same can’t be said about the 
MacBook Pro and MacBook Air. Rumours now 
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suggest that the MacBook Air and MacBook Pro 
lines will be updated during WWDC 2016 in June. 
Why is that confusing? Well…

Some reports suggest that the entire MacBook 
Air line may be discontinued, leaving users with a 
choice between the MacBook and MacBook Pro, 
simplifying the Mac laptop range. However, some 
suggest that only the 11.6in variation of the Air will be 
ditched, and will instead be replaced by a larger 15in 
model to sit along the more popular 13in model. 

The 13in Retina MacBook Pro could see an update 
at WWDC 2016, a laptop range that is over a year 
old at the time of writing. The larger 15in Retina 
MacBook Pro could also see an update, but due to 
the company releasing an update at the back end of 
2015, we’re not sure that is true. Rumours suggest 
that the new laptop could have significant gains 
in graphical performance due to new AMD/Nvidia 
GPUs and will feature Intel’s latest Skylake chipset.
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 Apple put Siri, its voice‑activated personal 
assistant, in the iPhone, iPad, Apple Watch, 
and Apple TV, but not the Mac. We assumed 

the company realised that people talking to their 
computers would be rage‑inducing to those around 
them, but OS X has had dictation features for a 
while, and Apple has actually been testing Siri on 
the Mac for the past four years.

Apple looks set to make its virtual assistant one of the 
flagship features in OS X 10.12, reports Caitlin McGarry

News: Siri for Mac  
coming this autumn
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The feature is almost ready to go, 9to5Mac 
reported recently (tinyurl.com/j4lnw99), and will 
be announced at the annual Worldwide Developers 
Conference as part of OS X 10.12 in June. The next 
version of the Mac operating system is likely to get 
a public release this autumn.

So how will Siri on the Mac work? Kind of like 
Spotlight search, in that a Siri icon will sit in your 
menu bar until you need to use it. Click it, and a 
transparent overlay will pop up in the top right 
of your screen with the same colourful waves 
you see on your iPhone screen, which indicates 
that Siri can hear you speaking. If your Mac is 
plugged in, you’ll be able to say “Hey, Siri” and 
get a response without clicking.

It’s unclear exactly why Apple waited so long 
to bring Siri to OS X, but 
according to 9to5Mac, the 
company may not have had 
a good idea of what it would 
be useful for (we’re still 
sceptical, to be honest), or 
what the interface should look 
like. Those problems have 
reportedly been resolved.

Some Mac users have 
been waiting for years 
– since Mountain Lion  
(tinyurl.com/j587s5r) – for 
Apple to put Siri in OS X. 
We don’t get the appeal, but 
we are open to the idea if 
Siri proves to be incredibly 
useful on the Mac.

JUNE 2016 • MACWORLD  11
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 With the help of security researchers, Apple 
recently quickly blocked a cyberattack 
aimed at infecting Mac users with 

file‑encrypting malware known as ransomware.
The incident is believed to be the first Apple‑

focused attack using ransomware, which typically 
targets computers running Windows.

Victims of ransomware are asked to pay a fee, 
usually in bitcoin, to get access to the decryption 
key to recover their files.

First Mac ransomware seeded inside a legitimate BitTorrent 
application called Transmission, writes Jeremy Kirk

News: Apple shuts down 
Mac ransomware attack
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Security company Palo Alto Networks wrote 
that it found the ‘KeRanger’ ransomware 
wrapped into Transmission, which is a free 
Mac BitTorrent client. Transmission warned on 
its website (transmissionbt.com) that people 
who downloaded the 2.90 version of the client 
“should immediately upgrade to 2.92”.

Sneaking past the Gatekeeper
It was unclear how the attackers managed to 
upload a tampered version of Transmission to the 
application’s website. But compromising legitimate 
applications is a commonly used method.

“It’s possible that Transmission’s official website 
was compromised and the files were replaced by 
recompiled malicious versions, but we can’t confirm 
how this infection occurred,” Palo Alto Networks 
wrote on its blog (tinyurl.com/zybzhqz).

The tainted Transmission version was signed 
with a legitimate Apple developer’s certificate. 
If a Mac user’s security settings are set to allow 
downloads from identified Apple developers, 
the person may not see a warning from Apple’s 
Gatekeeper (tinyurl.com/ju5dtv4) that the 
application could be dangerous. Security researcher 
Patrick Wardle of Synack has previously disclosed 
flaws in Gatekeeper (tinyurl.com/hdsgdqk) that 
can lead to malicious code being installed from 
seemingly legitimate sources.

Apple revoked the certificate after being 
notified, Palo Alto wrote. The company has also 
updated its XProtect antivirus engine.

After it is installed on a system, KeRanger 
waits three days before connecting to a remote 

MWJUNE16.indd   13 19/05/2016   12:36



14  MACWORLD • JUNE 2016

command‑and‑control server using the Tor system. It 
is coded to encrypt more than 300 types of files.

The ransom is 1 bitcoin, or about £316.

Ransomware is hard to catch
There are few defences against ransomware. 
Antivirus programs often do not catch it since the 
attackers frequently make modifications to fool 
security software. The best method is to ensure files 
are regularly backed up and that the backup system 
is isolated to protect it from being infected as well.

Ransomware schemes have been around for 
more than a decade, but over the past few years 
have spiked. At first, the attacks struck consumer 
computers, with the aim of extracting a few hundred 
dollars. But it appears attackers are targeting 
companies and organizations that may pay a much 
larger ransom to avoid disruption.

Although OS X’s share of the desktop 
computing market is much lower than Microsoft’s, 
cyberattackers have been showing increasing 
interest in it. But so far, ransomware hasn’t been a 
problem, although some researchers have created 
proof‑of‑concept file‑encrypting malware for Macs.

Last November, Brazilian security researcher 
Rafael Salema Marques published a video  
(tinyurl.com/j7gugdu) showing how he coded 
ransomware for the Mac in a couple of days. 
He didn’t release the source code.

Also, OS X security expert Pedro Vilaca 
posted proof‑of‑concept code on GitHub  
(tinyurl.com/hplp98q) for Mac ransomware he 
wrote, another experiment showing how simple 
it would be for attackers to target the platform. 
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From £1,049 inc VAT • apple.com/uk 

 Apple finds itself in a simultaneously difficult 
and enviable position in 2016. Having cast 
its spell over the laptop, the smartphone and 

the tablet, it has run out of things to revolutionise, 
things to invent. It seems that Apple is starting to 
plateau, in both creative and financial terms, but 
(perhaps unfairly) it must live up to its own hype 
every time it releases a product. Such as this 
amazing MacBook, an update to the original 12in 
MacBook unveiled in 2015.

Much like the original MacBook Air caused 
outrage among tech hacks by having only one USB 
port (Apple later relented and added a second), 
so the 12in MacBook courted controversy by 

Review: MacBook (2016)
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featuring a lone USB‑C port, which also serves as 
the power connector: the world promptly decided it 
wasn’t ready for a single‑port laptop with a slightly 
different keyboard. We feel this is the wrong way of 
looking at this laptop – in a simpler world it is one of 
the best laptops you can buy. But it isn’t that simple, 
and it will be compared to not only the rest of the 
world’s computers, but also the incredible track 
record of the company that has made it.

There’s no intended niche audience for this 
product – it is a laptop for everyone, a computer 
in its purest form that surely will shape the future 
of the portable computer. 

If only it weren’t so darned expensive.

Price
For a laptop that is marketed heavily as the future 
of computing, the price and specs are both slightly 
confusing and undeniably high. It’s available in 
two base models, priced £1,049 and £1,299. 

Perhaps the price jars because of the way 
consumer technology has fallen over the past 
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20 years. You may remember the days of the 
first family PC costing well over £1,000, but you 
can now pick up a Windows laptop with higher 
specs than the MacBook for around half its price. 
Then again, this high price buys you an incredible 
feat of laptop engineering that weighs about as 
much as a tablet, yet (despite Apple’s iPad Pro 
marketing) can do a tad more.

The 2016 MacBook is available in Space Grey, 
Silver, Gold and, oh yes, Rose Gold. 

Performance
We’ve been using the standard 1.1GHz model, which 
has an Intel Core m3 processor. The 2015 Retina 
MacBook’s legacy has been, and will remain, that it 
wasn’t very powerful. So far we have no complaints 
against the 2016 model in day‑to‑day use – it zips 
along very nicely for all your everyday computing 
needs – but we don’t expect groundbreaking 
scores when we put the MacBook through our 
battery of speed benchmarks. 

There won’t be any tech snobbery here, 
incidentally, against the idea of ‘everyday 
computing’, as though all tech journalists and 
specialists actually need and frequently use the 
power of the MacBook Pro they probably own. The 
2016 MacBook, even in its lowest‑spec model, is 
more than adequate for the needs of most, although 
video editors and gamers should look elsewhere.

It’s the first Apple MacBook to ship with Intel’s 
latest generation of processor, ‘Skylake’. Along with 
Intel’s HD Graphics 515 card, the MacBook has faster 
performance and storage speeds across the board. 
It’s fair to say that these aren’t extremely noticeable 
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in use compared to the 2015 model, but the 
laptop is agile and responsive. 

The standard 8GB of RAM helps, as does 
the flash storage – there are no moving parts in 
this laptop, and therefore no fan. It barely runs 
warm, even when put under a bit of pressure 
with multiple programmes running. A laptop that 
doesn’t scald your lap is always a plus. 

Bonus points: pleasingly for a laptop this small, 
the speakers are outstanding.

Design
We’ve been playing with an attractively grey (Space 
Grey, because space is grey) model which has 
picked up many compliments on its short travels. 
There’s no denying this is a beautiful product.

Instead, we are drawn to notice, and potentially 
criticise, the one sole port on this computer. (Bar the 
headphone port. First name on the team sheet.) It’s 
USB‑C, a relatively new standard of USB connection. 
The bundled charger connects to the port, which is 
also able to transfer data and act as a video output 
port. You’ll need an adaptor to do all three at once. 

But so what? If you know you’ll want to attach 
several USB sticks to your computer every day, then 
you just won’t consider this laptop – much like those 
who will want to connect an external monitor. The 
MacBook doesn’t support Thunderbolt 3, so the best 
option for second screening is with an HDMI adaptor 
to connect to a compatible monitor. 

But if you really think you’d want to connect this 
particular MacBook to an external monitor, why 
would you plump for a 12in screen laptop in the 
first place? A 15in MacBook Pro with a plethora of 
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ports is surely your preferred machine, negating 
the need for an external display. The point here is 
that the design of this laptop should not be judged 
harshly by what it cannot do in relation to its price. 
This is to misunderstand its excellent combination 
of form and function.

Unfortunately, for the next couple of years, the 
one USB‑C port thing is probably going to affect 
sales of this laptop. Given that Apple has gone 
with it again for the second generation, we think 
Apple is sticking with this strategy for the long 
haul – we’ll have to wait and see what the next 
MacBook Pro brings. Some users will feel they 
might need to suddenly plug in two USB sticks 
and the SD card for that point‑and‑shoot camera 
that’s lying about somewhere. The MacBook Air 
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is now considered a design classic used by several 
generations of person, and indeed allows these 
plug‑ins, but in 2008 it was actually laughed at 
by many for being overpriced and only having a 
single port. Sound familiar?

Keyboard and trackpad
Apple has made the travel of the MacBook’s keys 
particularly shallow in order to squeeze the size of 
the chassis down, but it’s not as far removed from 
other more traditional typing surfaces as reports 
might have you believe.

The company has made the keys larger than on 
its other keyboards yet amazingly has fit a full‑size 
design on to a laptop that is a hair over 11 inches 
wide. Yes, we’ll admit it feels different, but after a 
couple of hours of adjustment and typos, the words 
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flow. It’s not a compromise, it’s a design choice, 
just as the decision to buy this laptop is a choice 
of whether its design tweaks complement your 
computing needs.

Not only has Apple impressively included a 
full‑size keyboard in what is the ultimate portable 
form, but also has managed to fit a well‑sized 
trackpad. Much like the 2015 model, it is a Force 
Touch trackpad that doesn’t physically click, 
it just gives this impression: Apple created a 
space‑saving mechanism that uses electrical 
pluses to trick your brain into feeling a click. 
Press a little harder and you get a deep click, 
similar to 3D Touch on the iPhone 6s and 6s Plus. 

This is useful to pop up dictionary definitions 
within web browsers when words flummox you. 
Really, though, the absence of another traditional 
moving part has allowed Apple to shave a 
few millimetres off the MacBook’s design. The 
standard feel of the trackpad Apple has pioneered 
is still there – namely, the most responsive and 
pleasing to use on the market.

Display
Where Apple has differentiated this MacBook line 
from its aging MacBook Air is in the screen. It’s 
amazing. It has Apple’s Retina display, but then 
again, so did the iPhone 4 in 2010. Why Apple has 
resisted adding such an impressive display to the Air 
is now slowly being answered by its inclusion here.

The MacBook, in all current models, only ships 
with a 12in screen option. It has a 2304x1440 
resolution at 226 pixels per inch (ppi). In real‑life use, 
it is one of the best screens we have ever seen on 
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a laptop, with an outstanding range of colours and 
backlight brightness levels, the auto‑adjustment of 
which is second to none in its accuracy. You can 
also scale the resolutions, the most useful being the 
‘More Space’ option that pushes the 12in display to 
its most spacious for multitasking.

In comparison to the cheaper MacBook Air, the 
screen has a better resolution but also a more 
pleasing screen‑to‑bezel look. Only since this 
laptop’s design premiered in 2015 have people 
begun to consider the Air as looking a bit aged. The 
Air’s thicker, plastic grey bezel now looks outdated 
and unnecessarily wide compared to the sleek, thin 
glass black bezel of the MacBook. It’s a small touch, 
but adds to the premium look and feel of the device.

Battery
The battery, despite the improvements, is not as 
good as the current crop of MacBook Airs and Pros. 
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This comes down to simple physics: this computer 
is tiny, and Apple has done its best to cram as 
much battery as possible in there.

The new Skylake processor performance 
allows for slightly improved battery consumption 
compared to last year’s model, and Apple quotes 
up to 10 hours of wireless web use. Using the 
2016 MacBook day to day we found we could go 
through the working day without having to plug 
the mains charger in.

We noticed a sharper drop in the battery levels 
once you fire up a fair few tabs in Chrome (a famous 
MacBook energy sapper), along with apps like Mail, 
Slack, Notes and Google Drive, as well as video 
playback all chipping in now and then.

What we describe here is many people’s daily 
work needs, and the MacBook offers more than 
acceptable battery performance for a laptop for 
these needs. All laptops decrease with this kind of 
usage. If you really baulk at the 10 hours quoted, it’s 
possible that you’ve been spoilt by the MacBook Air. 
And fair enough, if you need to push 15 hours away 
from a plug, coffee shop hopping and working on 
the go. Your job sounds chilled.

Macworld’s buying advice
There’s no escaping the fact that this is a very similar 
laptop to its 2015 predecessor, which so divided 
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the tech community. But we think the problems 
have been overblown. The engineering on show 
is superb, and the performance is completely 
acceptable for a modern‑day computer of this 
size. The arguments that there should be more 
ports on the MacBook only exist because people 
want one, and are frustrated that their current 
set‑up needs will not allow for it.

Apple has undoubtedly improved the MacBook 
for 2016. It is a truly outstanding laptop that will be 
wrongly categorised as a luxury technological item. 
There’s a difference between something costing a 
little too much and it being luxurious – just like the 
MacBook Air, this laptop deserves to fall in price and 
rise in specs to continue to be what we consider an 
excellent flagship computer. The world and its ports 
just need to catch up. Henry Burrell

Specifications
£1,049 MacBook
•  12in (2304x1440, 226ppi) LED‑backlit display 

with IPS technology
•  OS X El Capitan
•  1.1GHz dual‑core Intel Core m3 processor 

(Turbo Boost up to 2.2GHz) with 4MB L3 cache
•  8GB of 1866MHz LPDDR3 RAM
•  256GB PCIe‑based onboard flash storage
•  Intel HD Graphics 515
•  802.11ac Wi‑Fi
•  USB‑C
•  480p FaceTime camera
•  41.4Wh lithium‑polymer battery
•  280.5x196.5x13.1mm
•  920g
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£1,299 MacBook
•  12in (2304x1440, 226ppi) LED‑backlit display 

with IPS technology
•  OS X El Capitan
•  1.2GHz dual‑core Intel Core m5 processor 

(Turbo Boost up to 2.7GHz) with 4MB L3 cache
•  8GB of 1866MHz LPDDR3 RAM
•  512GB PCIe‑based onboard flash storage
•  Intel HD Graphics 515
•  802.11ac Wi‑Fi
•  USB‑C
•  480p FaceTime camera
•  41.4Wh lithium‑polymer battery
•  280.5x196.5x13.1mm
•  920g
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From £499 inc VAT • apple.com/uk 

 The 9.7in iPad Pro, Apple’s appealing new mid‑
size tablet, proves that while laptops might 
still be the best tool for working on the go, 

they’re no longer necessary. We evaluate its build 
quality and new features, put the device through our 
rigorous speed benchmarks and battery‑life tests, 
and compare the value for money it offers compared 
to other iPads (and rival tablets) on the market.

Review: 9.7in iPad Pro
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Design 
If you’ve seen the iPad Air 2 then you’ve pretty 
much seen the 9.7in iPad Pro too. They’re virtually 
identical; the physical dimensions match up, down 
to the nearest gram or tenth of a millimetre, and 
the positioning of almost all the buttons, slots, 
apertures and so on is the same.

Yet some minor and a couple of significant 
differences can be discerned by the eagle‑eyed.

Minor: the cellular antenna section at the top of the 
back of the (cellular‑capable) iPad is now mostly 
the same metallic finish as the rest of the back, with 
just its edge picked out in white or black plastic, 
and therefore looks nicer than the entirely plastic 
section on the iPad Air 2 (and on the cellular 12.9in 
Pro, for that matter); the word ‘iPad’ on the back 
is now picked out in the thinner and to our eye 
better‑looking San Francisco font; the SIM card 
slot has migrated fractionally higher up on the 
side of the device; and there’s a pink (sorry, Rose 
Gold) colour option.

Significant: the speakers at the bottom of the iPad 
are now spaced further apart (which is sensible; 
they used to be crammed so close to the Lightning 
port that you had no chance of making out a stereo 
effect) and a third and fourth speaker sit on the 
top edge, giving an altogether more formidable 
audio setup; there’s a discreet Smart Connector 
on the lefthand edge, for attaching and powering a 
keyboard case; and the rear‑facing camera is now 
accompanied by a flash (and sticks out a bit, like the 
camera on the iPhone 6 and 6s generations).
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The protuberant camera lens is quite annoying: 
if you lay the iPad flat on its back, particularly 
on a hard surface, then one corner is raised up 
awkwardly, and it scratches against the desk if 
you push it around. If you equip your iPad with 
a case or cover, however, this will be far less of 
a problem: we habitually use the Smart Cover, 
which means the iPad almost always has the cover 
tucked underneath when it lies on a table.

For those who don’t know the iPad range 
in general, it’s worth stating for the record that 
the 9.7in iPad Pro, like all of its stablemates, is 
beautifully designed and engineered.

There are many lovely touches, from the charming 
contrast between the brushed‑metal sides and 
the narrow gloss chamfer (which we think looks 
particularly nice in the new pink finish) to the subtle 
rounding on the back edges, toned down from the 
original iPad, but still present all these years later, 
which makes the iPad easier and more inviting 
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to pick up. But Apple has been turning out such 
delights for many years, so we had better move 
on and look at the new features.

Display
The 9.7in iPad Pro comes, as the name makes 
clear, with a 9.7in touchscreen Retina‑class display: 
one that matches in size, resolution and (mostly) 
functionality the screen on its predecessor.

The 2048x1536 resolution produces a pixel 
density of 264 pixels per inch (ppi), which is standard 
issue for Apple’s tablets, and pleasingly sharp to the 
eye, but given that Apple routinely sells iPhones with 
a pixel density of over 400ppi, it can scarcely argue 
any more that Retina resolutions are the best that 
the human eye can discern. You can get a tablet with 
a pixel density above 350ppi if you’re willing to go 
over to the Dark Side and buy from Samsung.

Our subjective experience of the screen is that 
it is merely excellent, and we weren’t immediately 
struck by any differences from the iPad Air 2. But 
Dr Raymond M. Soneira, from DisplayMate, has 
run detailed specialist tests on the two screens’ 
performance and concludes that the Pro is a 
measurable step forward in a number of areas: 
colour output, reflectivity, brightness. The Pro’s 
display, he goes on to conclude, “is visually 
indistinguishable from perfect, and very likely 
considerably better than any mobile display, 
monitor, TV or UHD TV that you have.”

After reading the expert’s rave reviews on the 
iPad Pro’s reduced screen reflectivity, we looked 
again at its performance in bright sunshine, next to 
windows, under electric lights, and so on. Several 
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members of the Macworld team were convinced that 
reflections were indeed less of an issue than with 
the Air 2, and that screen legibility would be better 
outdoors. But this was subjective: others struggled 
to spot the difference. Your mileage may vary.

The most intriguing difference between the 
screens on this iPad and the Air 2 is a new feature 
called True Tone. (A feature so new that it is denied 
to those who buy the 12.9in Pro.) This is designed to 
subtly adjust the screen’s colour output to account 
for environmental light conditions.

Having only recently got used to the shocking 
colour adjustment imposed by Night Shift on default 
settings (we’d strongly recommend toning it down), 
we struggled to notice True Tone’s far more subtle 
changes at first. But sitting at a desk under electric 
light in late afternoon with the 9.7in iPad Pro and 
the iPad Air 2, it’s fairly clear that True Tone is gently 
warming things up – a kind of watered‑down version 
of Night Shift. This should carry on doing its thing 
in the background throughout your day, and the 
nice thing is that you don’t need to worry about 
it, just getting a slightly better and more context‑
appropriate screen performance.

Again, we turn to the expertise of Dr Soneira for 
a technical examination of this feature. He points 
out first of all that while True Tone automatically 
changes both the White Point and colour balance 
of the display, Night Shift changes colour balance 
only. But he also sounds an alarm about True Tone’s 
affect on colour fidelity in some circumstances:

“When we turned on True Tone under 
incandescent lighting with a Colour Temperature of 
about 3,000K, the Colour Temperature of the 9.7in 
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iPad Pro White Point shifted from 6,945K to 5,500K, 
which is quite noticeable and visually significant, 
but it doesn’t come close to matching the colour of 
reflected light from white paper. The colour change 
with ambient light may be better for reading text on 
the screen’s white background.

“And most users might not want such a 
drastic colour change with ambient light anyway, 
which would affect and significantly reduce the 
Absolute Colour Accuracy of all image content 
(including photos and videos), one of the iPad 
Pro’s strongest features. My recommendation is 
that True Tone needs a Slider adjustment so that 
each person can vary the magnitude of the effect, 
from very little to a lot.”

There isn’t yet a slider – as there is for Night 
Shift – but if you don’t like the effect, you can turn 
off True Tone completely: which is also good for 
evaluating the effect you’re getting if you haven’t 
got a non‑True Tone iPad to compare it to.

Performance
The 9.7in Pro is equipped with Apple’s proprietary 
A9X processor and M9 motion co‑processor – the 
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same components used in the 12.9in Pro and the 
most powerful mobile chipset that Apple currently 
uses. (For comparison, Apple claims that the 
A9X chip, as used in the 9.7in Pro, is 2.5x faster 
at general processing than the iPad mini 2’s A7, 
and 5x faster at graphics processing.)

It’s searingly fast, and comfortably powerful 
enough to handle anything on the App Store now 
and for the next couple of years. Indeed, unless 
you’re keen to run the most graphically intensive 
games or demanding creative or work apps, it’s 
hard not to regard this as spec overkill.

We continue to use the office iPad Air 2 for a 
range of new and demanding games and work 
tasks and haven’t observed any slowdown yet, but 
in terms of future‑proofing the 9.7in Pro is clearly a 
better long‑term bet. The Air 2, particularly if you 
plan to regularly update iOS, won’t stay fast forever.
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In our speed tests the 9.7in Pro was streets ahead 
of the Air 2 (that’s a theoretical advantage, though 
– the real‑world experience for the two is similar at 
present) and in most tests only slightly behind the 
12.9in Pro. The larger iPad remains a faster machine 
overall because of its extra RAM – 4GB compared to 
the 9.7in model’s 2GB – but the greater demands of 
that device’s larger, higher‑resolution screen mean 
that in onscreen tests the gap is fairly small. The gap 
was more noticeable in the offscreen sections of 
the GFXBench tests.

Battery life
The 9.7in Pro comes with a 7306mAh rechargeable 
lithium‑polymer battery. That’s pretty much the same 
capacity as the one in the iPad Air 2 (7340mAh), 
but coming 18 months further down the tech‑
development line it wouldn’t be unreasonable to 
expect slightly improved power efficiency.

In fact, the 9.7in Pro exceeded expectations in its 
first battery test, achieving a score in Geekbench 3’s 
battery component of 6,711; that’s only a little lower 
than the 6,865 scored at launch by the 12.9in iPad 
Pro  (which has a far larger battery – 10,307mAh – 
albeit one that has to power a far larger screen), and 
well ahead of the iPad Air 2’s 4,601.

This seemed impossibly good, so we repeated the 
test a week later. This time the 9.7in Pro laid down 
a score of 6,535 – slightly lower, but still extremely 
impressive. That’s a terrific average score of 6,623.

To put that into the context of actual times, those 
three iPads lasted 11 hours 11 minutes (9.7in Pro), 11 
hours 26 minutes (12.9in Pro) and seven hours 40 
minutes (Air 2) respectively. Bear in mind that this is 
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a demanding test and real‑world battery life is likely 
to be significantly higher. In its second test, the 9.7in 
Pro lasted 10 hours 53 minutes.

Predicting battery life, for that matter, is never an 
exact science. But we’re satisfied that the 9.7in Pro 
is easily capable of matching the “up to 10 hours of 
surfing the web on Wi‑Fi, watching video or listening 
to music” or “up to nine hours of surfing the web 
using a mobile data network” that Apple claims for 
all five of its current iPad offerings.

Cameras
The 9.7in Pro has the best rear‑facing camera of 
any current iPad – and that, annoyingly for last 
September’s early adopters, includes the 12.9in Pro.

The 9.7in model’s back camera is rated at 12Mp 
with an f/2.2 aperture, compared to the 8Mp/f/2.4 
offered by the larger Pro, the Air 2 and the mini 
4, and the 5Mp/f/2.4 model on the mini 2, and it’s 
been equipped for the first time with a flash.

It also gets the Live Photos feature, where short 
snatches of video are captured before and after 
still photos so they can be animated, that we’ve 
previously seen on iPhones only; 4K video recording 
(up from 1080p); a sort of ‘super slow‑mo’ option 
(240fps, up from 120fps) as well as the option to 
shoot 120fps slow‑mo at 1080p, up from 720p; larger 
panoramas (63Mp, up from 43Mp); auto HDR; and a 
focusing feature that Apple calls Focus Pixels.

And the front‑facing camera is much improved, 
too, although in fewer ways: the megapixel rating 
has gone up from 1.2Mp (across the board) to 5Mp, 
and the 9.7in Pro gains the Retina flash feature 
– which lights up the screen as an improvised 
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front‑facing flash – that we know and love from the 
iPhone 6s and 6s Plus. It also gains auto HDR on the 
front‑facing camera, which the Air 2 and mini models 
don’t get, but unlike the rest of the improvements 
I’ve listed here the 12.9in Pro does get this one. 

Camera tests
We took the two sizes of iPad Pro, together with the 
iPad Air 2, out into the north London sunshine for a 
series of photo tests. In sunny weather most of our 
shots were of a broadly similar standard – despite 
the 9.7in Pro in theory having a substantially more 
capable sensor.

Our shot of St. Pancras Hotel in moderately 
overcast conditions was a better demo of the 9.7in 
Pro’s camera chops. There’s much more ‘pop’ to the 
Pro’s image, better contrast; the Air 2’s shot looks 
muddy and subdued in comparison (although bear 
in mind that both are decent shots which we’ve 
zoomed into quite heavily to seek out weaknesses).
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If you can bear it, take a look at these selfies , 
taken by the author with the front‑facing cameras. 
(Bear in mind that the photo taken by the 1.2Mp 
camera in the Air 2 is much smaller than that taken 
by the 5Mp iPad Pro, and we’ve blown the former 
up even more for a comparison of how well each 
shot stands up to a heavy zoom.) You can clearly see 
more pixellation in the Air 2’s selfie, as you’d expect.

We gave the Retina flash a quick try‑out too. A 
comparison wasn’t really possible here, since none 
of the other iPads have any kind of flash on their 
front‑facing camera, but we took an unflashed shot 
with the iPad Air 2 just so you can see what you’d 
be stuck with if taking a selfie in the dark.

The Retina flash does a surprisingly decent job of 
lighting the subject, with colours holding up well and 
no noticeable overexposure, although there’s a bit of 
blurring around the bottom of the picture.

Speakers and audio quality
The 9.7in model, like the larger Pro, comes with 
four speakers: the two speakers at the bottom of 
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all currently available iPad models (albeit spaced 
more widely than on the iPad Air 2 and minis), and 
two more on the top edge. The speakers are still 
very slightly backward‑tilted, however, sitting as 
they do on the iPad’s gently curved edges.

It’s a huge step forward sonically. The iPad 
Air 2 has always had mediocre audio output, but 
this is particularly cruelly exposed when playing 
songs and films at top volume alongside the 9.7in 
iPad Pro, which has a much fuller, richer sound: it 
fills our small test centre with clear, warm audio. 
The Air 2, by contrast, provides essentially no 
stereo effect whatsoever, since its speakers are so 
close together, and sounds desperately thin (and 
lopsided) after listening to the Pro.
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Screen space is still a compromise, but in terms of 
sound the 9.7in Pro now feels like a legitimate choice 
for spare‑room film nights – no longer do you need 
to plug in headphones for the proper experience. It’s 
also a far more appealing option as a portable music 
device for the kitchen or picnic table.

The 12.9in tablet is still ahead in this department, 
however. It’s possible that the speakers themselves 
are beefier, although Apple doesn’t release specs 
for these and may have just used the same audio 
setup in both models; more likely the slightly better 
audio simply reflects the larger separation between 
speaker units. 

Accessories
The 9.7in Pro is equipped to run the same types of 
accessories as its larger cousin. Its screen works 
with the Apple Pencil, and there’s a Smart Connector 
port on the lefthand edge for attaching a (smaller 
version of the) Smart Keyboard cover.
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The Apple Pencil is an attractive and well‑
balanced stylus that makes for extremely smooth, 
accurate and lag‑free drawing, digital ‘painting’ and 
note‑taking. Having this option takes the 9.7in Pro 
to the next level as an artistic tool – although like 
most Apple kit the Pencil is among the costliest 
options in its field. It isn’t bundled with the tablet 
and will cost you a further £79.

The 12.9in version of the Smart Keyboard is 
essentially full‑size. For reasons of weight and 
slimness, the keys have a shallower action than 
those on a standalone keyboard for a desktop 
Mac – instead of a pleasing butterfly or scissor 
mechanism, the keys are kept in position by the 
tension in their covering fabric – and this makes 
them less satisfying to use. 

But the familiar layout and size of the keys (if 
not shape – they’re more rounded than you’ll 
be used to) makes it surprisingly accurate. Not 
as accurate as a conventional keyboard, but 
accurate enough once you get used to it.

The 9.7in Smart Keyboard is a different matter. 
Its keys still feel a bit cheap, as a result of the 
shallow, weightless action, but because of their size 
(fractionally smaller than the pad at the end of my 
fingers, whereas the 12.9’s keys are slightly larger, 
which feels like a significant difference) they’re pretty 
hard to use accurately too: switching from the 12.9’s 
keyboard, or certainly from a conventional keyboard, 
is painful. It looks and to an extent feels like a toy.

As with the 12.9in model, however, practice will be 
rewarded, and this certainly isn’t a disaster: indeed, 
for a keyboard of its size it’s pretty usable. But of the 
many aspects of the 9.7in Pro’s quest to be taken 
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seriously as a work tool, its keyboard is the most 
glaring weakness.

(An extremely small side complaint: the lower 
weight of the 9.7in keyboard accessory means it 
doesn’t sit completely flat on the table ‑ the front 
often lifts up slightly as the tablet pulls down on the 
back of the setup. We’ve tried two separate review 
samples here and both suffered from this – very 
minor – issue. Yet Apple assures us this is not a 
widespread problem.)

This won’t be the only keyboard for the 9.7in 
Pro, of course. Many of Macworld’s 12.9in model 
owners prefer the Logitech Create Backlit Keyboard 
Case to Apple’s offering, and we assume that a 
version of this for the 9.7in Pro will appear before 
long. But if you do give Apple’s own iPad keyboard 
a go, prepare your wallet for a battering: the 9.7in 
version of the Smart Keyboard will set you back an 
eye‑watering £129.

Macworld’s buying advice
The price is high and at first glance slightly 
annoyingly so: given that the 9.7in Pro is externally 
almost identical to the iPad Air 2, Apple may have 
a hard sell convincing the average user to part 
with £839 when the top‑end Air 2 cost £659 at 
launch, albeit with half the storage. (Business users 
– and Apple is pushing this tablet into the laptop‑
replacement sphere – will presumably find the 
pricing less off‑putting.) Still, we think you get more 
than enough to justify the £60 premium over the 
equivalent launch‑day iPad Air 2.

This is a considerably faster device than its 
predecessor – very nearly as quick in a lot of tests, 
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indeed, as the 12.9in Pro, despite having half the 
RAM. As ever, we must point out that this won’t 
make a difference just yet in your day‑to‑day usage, 
but offers far more future‑proofing and the ability to 
run the most demanding apps and games for years 
to come. But the presence of the mega‑powerful 
Pro devices at the top of Apple’s range gives app 
developers licence and encouragement to push 
their wares in more ambitious directions. And other 
than the RAM and the oversized screen, the 9.7in 
Pro gets every single upgrade offered by the larger 
model, and quite a few that it doesn’t.

You can now use the Apple Pencil and the Smart 
Keyboard with your mid‑size iPad, instantly making 
this a more appealing device for work on the go, 
and particularly for creative design work and note‑
taking; and quad speakers make it a superior option 
for films and TV on the go, and make for better and 
more immersive gaming and music playback.
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Leaping beyond the 12.9in Pro’s enhancements, 
the 9.7in Pro gets a True Tone colour‑adjusting 
screen, heavily improved front‑ and rear‑facing 
cameras (including 4K video recording, Live Photos 
and the Retina Flash) and the option for a pink 
colour finish. And unlike with the older Pro, buyers 
of the smaller Pro get the full range of storage 
options (including, for the first time on an Apple 
mobile device, 256GB) from launch.

The added improvements in the last paragraph 
will be galling for early (or even moderately tardy) 
buyers of the 12.9in model, who have every right 
to feel stitched up; they imagined themselves to 
be buying what would remain the top‑end iPad for 
a good 12 months and now have to watch an even 
better (but cheaper) model come out, along with 
new options for the larger Pro that they didn’t have 
access to, a scant six months later. Then again, 
instant obsolescence is par for the course as a tech 
buyer. And writing as I am for prospective buyers of 
the 9.7in Pro, those upgrades are great news.

The smaller Smart Keyboard isn’t a convincing 
replacement for a full‑size layout, and for mobile 
business users this is still a compromise in terms of 
screen space and range of available apps (even if 
the latter issue will dwindle and die as time passes). 
But overall we find this a strong and appealing 
mid‑size tablet that advances the argument that 
while laptops might still be the best tool for working 
on the go, they’re no longer necessary. David Price

Specifications
•  iOS 9.3
•  9.7in (2048x1536, 264ppi)
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•  A9X with 64‑bit architecture. M9 coprocessor
•  Dual‑core PowerVR Series 7XT
•  4GB LPDDR4 RAM
•  32‑, 128‑, 256GB
•  12Mp iSight with Focus Pixel and True Tone flash, 

full‑HD recording at 60fps and 4K at 30fps
•  5Mp with Retina flash, support for HD 

video recording
•  Wi‑Fi: 802.11a/b/g/n/ac Wi‑Fi
•  Dual channel support (2.4‑ and 5GHz) 

and HT80 with MIM
•  Bluetooth 4.2
•  LTE, HSDPA+ and CDMA UK bands
•  Nano‑SIM (supports Apple SIM)
•  27.5Wh lithium‑polymer battery
•  GPS and GLONASS, Touch ID, Apple Pencil
•  169.5x240x6.1mm
•  437g (Wi‑Fi model), 444g (cellular model)
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 Apple recently added a new iPhone to its 
range of handsets – the SE. Designed as a 
replacement for the three‑year‑old 5s, the 

last 4in iPhone, it’s a great‑looking device that packs 
quite a performance punch.

£359, 16GB; £439, 64GB • apple.com/uk  

Review: iPhone SE
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Design
The iPhone SE is, in terms of design, the 5s – but 
that isn’t necessarily a bad thing. It’s crafted from the 
same bead‑blasted aluminium as the 5s, providing 
users with a smooth finish that doesn’t show 
fingerprints, although it isn’t the strengthened Series 
7000 aluminium present in the 6s. The blocky, edgy 
and industrial design of the 5s, in our opinion, at 
least, was before its time and looks as good today as 
it did when it was unveiled back in September 2013. 
It’s the small details of the design that make it what it 
is, from the matte‑chamfered edges to the stainless 
steel logo on the rear of the smartphone.

Many smartphone manufacturers are shying 
away from pointed edges, employing curved 
edges and even curved displays in some cases, 
as this provides users with something that’s more 
comfortable to hold, especially with a large display. 
However due to the small dimensions of the SE 
– 123.8x58.6x7.6mm to be exact – along with the 
pointed edges provides us with extra grip, with no 
real worry about the iPhone slipping from our hand, 
as curved smartphones like the 6s tend to do. It’s 
also lightweight at only 113g, making it 30g lighter 
than Apple’s flagship. In essence, if you’re looking 
for a small and lightweight smartphone, the SE 
looks to be a good option.  

If you do decide to grab yourself an SE, you’ll 
have a choice of colours to choose from. Along with 
the fairly standard Silver, Space Grey and Gold you’ll 
also find a Rose Gold colour option, Apple’s latest 
‘flavour’ that made its debut on the iPhone 6s and 
Apple Watch back in September 2015, and recently 
made its way to the 9.7in iPad Pro.
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Rumours suggest that Apple may ditch the 3.5mm 
jack on the iPhone 7 to make its flagship smartphone 
thinner than ever, which is, of course, bad news 
for those of us with expensive, wired headphones 
(and everyone else, too). Thankfully the 3.5mm jack 
is present on the SE at the bottom of the device, 
situated next to the Lightning port and speaker grille.

The lock button is in the same place as the 
iPhone 5s, at the top of the device, which 

may take some getting used to as 
many manufacturers now 

place the power button 
on the righthand 
side of smartphones. 
We found ourselves 
initially reaching to 
the right to lock it, but 
it’s something you get 
used to quickly. The 
circular (opposed to pill 
shape with the iPhone 
6 and newer) volume 
buttons and silent mode 
toggle are in the same 
place though, on the 
lefthand side of the 
iPhone SE. While we 
love familiarity, we’re 
disappointed that the 

Home button houses the 
same first generation Touch ID sensor as 
the iPhone 5s did, despite the 6s shipping 
with a much faster and more accurate 
second generation sensor.
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Of course, the biggest (or should we say 
smallest?) feature of the iPhone SE is its small 
4in display, allowing the smartphone to be used 
comfortably with one hand. Many users weren’t 
comfortable with the 4.7in and 5.5in iPhone 6s and 
6s Plus, and some even held back on upgrading 
because they couldn’t, for whatever reason, get on 
with a large display. We tend to use larger iPhones, 
so the experience of going from an 6s to an SE 
was strange – but in a good way.

We’d forgotten just how comfortable it is to hold 
a phone so small. We’d forgotten how easy it was 
to text and use one handed. We forgot about the 
magic of a small‑screen smartphone. Sure, there are 
downsides to having a smaller display; text is larger 
and fills up more of the screen, less information is 
displayed at once, pictures are a little harder to see 
and, in our opinion, games aren’t as enjoyable, but 
there’s something about the 4in smartphone that 
makes it a joy to use. It could be the reachability as 
we’re easily able to reach every button using our 
thumb, or it could just be that a smaller smartphone 
feels more secure and comfortable in the hand. 
Whatever it is, we’re a fan of it.

Display
Let’s talk a little bit more about that 4in display 
that so many Apple users were craving prior to the 
iPhone SE announcement. The SE features a 4in 
IPS LCD display which Apple markets as being a 
‘Retina display’. For those unsure of what a Retina 
display is, Apple coined the term to refer to devices 
that have a resolution and pixel density of around 
300ppi (pixels per inch) or higher, as the pixel 
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density is so high that the user is unable to pick out 
individual pixels at a normal viewing distance. It’s 
not to be confused with Retina HD either.

This is indeed true of the SE – the 4in iPhone 
boasts a fairly low resolution (when compared to 
Android smartphones anyway) of 640x1136, but 
because of the small dimensions of the display it 
equates to 326ppi, the same as Apple’s iPhone 6s.

While all that sounds impressive, what users can 
see and experience with their eyes is what is most 
important. The iPhone SE display is surprisingly 
crisp, but this is most apparent when looking at 
text. Why? The high pixel density display provides 
smooth curves and sharpness of text that can rival 
printed text, and this makes reading everything from 
text messages to eBooks on the small display a 
comfortable (and enjoyable) experience.

The same can be said with high‑quality photos 
– as long as the image you’re looking at is relatively 
high resolution, you can pick out tiny details in 
the photo that may not be visible on other, low‑
resolution smartphones. Colours are bright and 
vibrant too, although we wouldn’t mind seeing 
Apple employ a Super AMOLED display on one of 
its smartphones in future to provide the extra ‘wow’ 
factor that many Android rivals have.

3D Touch is one of the flagship features of the 
iPhone 6s and 6s Plus, allowing the display to 
measure the amount of force exerted instead of 
only registering touch input. Some claim that this 
will reinvent the way that iPhone 6s users interact 
with their smartphones, and we expect the feature 
to be present in every subsequent Apple flagship 
smartphone. Developers are integrating ‘peek and 
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pop’ integration into their apps and adding shortcuts 
to the home screen icons, providing users with 
completely new ways to interact with their apps. 
With such an emphasis on 3D Touch, we were 
hoping that the feature would make an appearance 
on the iPhone SE – but we were wrong.

There is no 3D Touch integration and while this 
probably isn’t a deal breaker for most, it could 
mean that the iPhone SE may get ‘left behind’ 
sooner rather than later. We’re not talking about 
iOS updates as the SE will be supported for years to 
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come – we’re talking more about in terms of features 
available to them. In the same way that iPhone 5 
(and earlier) users can’t use Touch ID as a form of 
identification in apps, iPhone SE users may not 
be able to perform actions that improve the overall 
app/iOS experience.

Interestingly, thanks to an iFixIt teardown, it was 
revealed that the iPhone SE features the same front 
panel as was used with the iPhone 5s. This means 
that both the display and front facing camera are the 
exact same as Apple’s 2013 flagship and while this 
isn’t necessarily a bad thing, it explains the lack of 
3D Touch integration.

Performance and benchmarking
Apple fans called for another 4in iPhone because 
the three‑year‑old iPhone 5s just isn’t up to scratch 
anymore, so it was important for Apple to make 
sure that the 4in iPhone SE was powerful enough 
to compete with other flagship smartphones on the 
market. The company seems to have succeeded, as 
inside the iPhone SE you’ll find Apple’s A9 chipset 
paired with an M9 motion co‑processor and 2GB 
of RAM – exactly what’s found in Apple’s flagship 
iPhone 6s and 6s Plus.

This means, generally speaking, that the iPhone 
SE should provide similar performance levels to 
its bigger and more expensive brother, the iPhone 
6s. In fact, due to the smaller resolution of the 4in 
display, it may even perform slightly better than the 
flagship Apple smartphone – in theory, anyway. But 
before we talk about benchmarking scores, let’s first 
talk about what the iPhone SE is actually like to use 
in terms of performance.
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The iPhone SE is rapid, there is no doubt about 
that. Swiping between app menus and opening 
apps is almost instant, and the SE doesn’t even 
stutter when opening the Camera – an area 
that notoriously slows down smartphones. Even 
though we mentioned above that the 4in display 
of the iPhone SE doesn’t provide the best gaming 
experience possible, that’s down to screen size and 
not performance. We’ve played a series of games 
on the iPhone SE from relatively simple platformers 
like Crossy Road to more power‑intense games like 
Geometry Wars 3: Dimensions and futuristic racer 
AG Drive with no sign of lag or unresponsiveness.

In fact, we even went out of our way to try and 
get the iPhone SE to fall over and stutter/lag by 
doing things like changing app while loading a 
power‑intensive game, or constantly opening and 
closing an app. All our efforts were futile, though, 
as the iPhone SE laughed at our poor efforts and 
didn’t even break a sweat, responding to every 
single tap. So it’s fair to say that the iPhone SE can 
match the iPhone 6s performance in general, but 
it’s time to talk specifics.
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We ran three separate tests – Geekbench, 
GFXBench and AnTuTu – to test the performance 
of the iPhone SE, and to make sure there were no 
anomalies in the results, we ran each test three 
times and took the average score of each.

In Geekbench 3, our first benchmark test, the 
iPhone SE scored 2254 in the single‑core test and 
4459 in the multi‑core test, which actually beat 
our iPhone 6s Geekbench results, (although not 
by much) by scoring 2511 and 4404 respectively. 
This puts the iPhone SE in line with the likes of 
the Galaxy S6 (4438) and Moto X Force (4455), 
two smartphones with similar pricing, suggesting 
that the iPhone SE performance is just right for 
its price tag. It also suggests that the iPhone 6s 
is underperforming based on its price, but that’s 
another story altogether.

In AnTuTu, a general performance benchmark 
test, the iPhone SE scored 123,981, which by itself 
means absolutely nothing. For reference, it’s not 
quite as good as the 6s which scored 134,067, 
but it is almost double the score of the last 4in 
iPhone, the 5s. The 5s managed only 64,901 
which, according to AnTuTu at least, suggests that 
the iPhone SE provides double the performance 
of its older sibling. It’s still not enough to beat the 
Galaxy S7 in this respect, though, as the flagship 
Samsung smartphone scored 129,077 in our sister 
publication PC Advisor’s test.

However, it’s in the graphics department that the 
iPhone SE really shines, and the GFXBench results 
speak for themselves. We ran two graphic‑intense 
benchmarks in GFXBench (Manhattan and T‑Rex) 
and measured the frame rate of each, and the 
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iPhone SE scored an impressive average score of 
58‑ and 60fps respectively.

Camera
The iPhone SE features a 12Mp rear facing camera 
which, contrary to popular belief, isn’t identical to 
the camera used in the flagship iPhone 6s. While the 
two cameras aren’t the same, the SE does have the 
same 12Mp sensor and fast image signal processor 
as the flagship iPhone, providing SE users with 
higher resolution images. This is especially true 
of panoramas, jumping up to a maximum of 63Mp 
compared to 28Mp photos possible with the iPhone 
5s. It also provides quicker capture times, which is 
what we’ve found in our tests – photos were taken 
almost instantly in our experience.

The SE also features Live Photo support, a feature 
that was (up until now) unique to the 6s and 6s 
Plus. When Live Photos is enabled in the Camera 
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app, you’ll capture a small video clip from before 
and after the photo was taken which can be played 
back at any time with audio. It provides users with 
a snapshot of a moment or memory and is a great 
feature to have when you’re feeling a little nostalgic. 

iPhone photography is a varied beast at the best 
of times – Apple’s smartphone cameras are great in 
well‑lit situations but tend to fail as the environment 
becomes darker. The SE takes beautiful photos 
in broad daylight, boasting detailed images with 
vibrant colours, however in darker situations the 
photos quickly become noisy, colours aren’t as 
vibrant and the images are slightly disappointing 
when compared to the competition. 

Even if you zoom into the opposite photo of 
St. Pancras, you’ll be able to pick out individual 
bricks of the building or pick out features of those 
walking by. Agreed, it’s not as great as other 
flagship smartphones like the Samsung Galaxy 
S7 but it was never meant to compete with £600+ 
flagship – if anything, it’s an issue with Apple’s 6s. 
However, when compared to a photo taken on an 
5s, the improvement is quite obvious to see:

The colours are more washed out, and the 
definition isn’t there – not even on the side of 
the building that is practically perfectly lit. In fact, 
in certain places the building looks smooth. The 
colours aren’t as vibrant as the photo taken by 
the SE either, obvious with both the colour of St. 
Pancras hotel and the sky above it. The 5s’s noise 
reduction is also a lot more obvious here, with the 
photo looking ‘smudgy’ when zoomed in.

The iPhone SE doesn’t do a bad job of taking 
photos in poorly lit environments, but we do believe 
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there are smartphones on the market that can do 
a better job – although maybe not at the same 
price of the SE. As you can see in the above photo, 
colours are generally more washed out than in a 
well‑lit photo, and the detail has largely disappeared. 
While you can still make out the various objects in 
the photo, zooming in really showcases the loss of 
detail. Evidence of Apple’s noise‑removing algorithm 
is more apparent here too, with the details becoming 
smudged inspected closely – take a look at the 
below crop to understand what we mean:

You may have noticed that we haven’t really 
talked about the front facing camera, and that’s 
because it’s the same 1.2Mp camera featured on old 
Apple smartphones like the iPhone 5s. There isn’t 
much to say about it really – it’s enough to use for 
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the likes of FaceTime and Snapchat, but not much 
else. To give you an idea of the quality available 
on other Apple devices, the iPhone 6s features a 
recently updated 5Mp camera.

The iPhone SE has 4K video recording 
capabilities, and like the 6s, you can also take 8Mp 
stills while recording. Of course, if that’s not your 
style then you can record 1080p HD at either 30‑ 
or 60 frames per second (fps), as well as having 
access to 1080p at 120fps and 720p at 240fps for 
slow‑mo action. The 1080p at 60fps video option 
provides gorgeous, smooth video but due to the 
higher frame rate, it falls flat on its face in dark 
environments. It’d make sense for Apple to offer 
some kind of toggle in the Camera app to quickly 
change between video modes, but this isn’t available 
at present and makes changing video formats a 
much more long‑winded process than need be.

Unlike the 6s, there is no optical image 
stabilisation for photos or videos but Apple claims it 
features “cinematic video stabilisation” – software 
that’ll automatically stabilise your photos. While 
we were initially sceptical about software based 
stabilisation, we were quite impressed by just how 
stable it was. While the video isn’t completely static, 
it has this beautiful smoothness to it that when 
combined with the 60fps frame rate is gorgeous. 

Battery life
Battery life is an important factor of any smartphone, 
and the iPhone SE doesn’t disappoint – although 
official battery life tests seemingly disagree. The 
iPhone SE features a 1624mAh battery, which is 
slightly bigger than the 1560mAh battery featured 
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in the iPhone 5s, and boasts with a more efficient 
processor, suggesting that the iPhone SE would 
have better battery life. Apple itself claims that the 
iPhone SE will manage up to 14 hours of 3G talk time 
or 13 hours of Internet browsing on Wi‑Fi and while 
we found it hard to confirm these claims, we found 
the iPhone SE battery life to be generally quite good.

We understand that ‘good’ isn’t the best word 
to use when describing the iPhone SE battery life, 
so it’s best to give real‑world examples based on 
our time with the smartphone. We, like many other 
commuters, use our iPhone to listen to music during 
our morning commute. When using our iPhone 
6s, we usually get to work with around 80‑ to 85 
percent battery remaining however when we used 
the SE, we found that it only drained by 8‑ to 10 
percent. While it’s not a huge difference when in 
use, the SE in standby lasted an impressively long 
time – we managed to go almost two days straight 
without charging the smartphone, although our 
usage was admittedly limited.
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So why don’t official battery tests support our 
real‑world usage claims? We’re not quite sure. We 
ran two battery life tests on our SE and according 
to the results, the smartphone lasted around four 
hours before it ran out of charge. In comparison, a 
decent Android smartphone can last from anywhere 
between six and nine hours on a single charge. 
We’re not quite sure why this is happening and it 
may be down to different methods of battery life 
benchmarking on iOS and Android, but we refuse 
to stand by the results and claim that the iPhone SE 
should go most of the day (if not all day, with normal 
usage) without needing a charge.

Software
The iPhone SE comes running Apple’s latest 
operating system, iOS 9 – more specifically, it 
should ship with iOS 9.3. While Apple’s iOS mobile 
operating system is essentially the same across all 
its devices, there are a number of features unique 
to a handful of smartphones including the iPhone 
SE. The biggest software feature of the iPhone SE is 
‘Hey Siri’ support, something only available on the 
latest Apple products including the iPhone 6s, 6s 
Plus and 9.7in iPad Pro. What is it? iPhone SE users 
can teach Siri to recognise their voice, and from that 
point can activate Siri hands‑free simply by saying 
“Hey Siri”. Siri, for those unaware, is Apple’s virtual 
assistant that can handle a variety of requests, from 
making calls to finding out the meaning of obscure 
words like ‘cantankerous’.

Along with Hey Siri, iOS 9 also introduced a 
contextually intelligent, predictive assistant that 
Apple refers to as ‘Proactive’. No, this doesn’t mean 
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that Siri will start having human conversations about 
your day – instead, you’ll be offered a series of 
shortcuts to various contacts and apps depending 
on your habits. Say, for example, you call your other 
half every day after work at 5.30pm. Proactive will 
learn this habit over time and at around 5.30, it’ll 
offer a one‑tap shortcut to call your partner. It’s the 
same with apps, and it’ll even offer a Music app 
shortcut on the lock screen whenever headphones 
are plugged in. As with Apple’s design philosophy, 
it’s the little things about iOS 9 that make it what it is.

Macworld’s buying advice
It was about time Apple updated its 4in iPhone 
line (and there remains a few of us whose small 
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hands and pockets will appreciate this more 
portable design), and this is a sensible refresh 
of a much‑loved product. We’d forgotten about 
just how nice it was to hold a 4in smartphone, 
and just how comfortable it was to handle 
one‑handed. It’s as fast as an 6s thanks to the 
A9 chipset and as portable as an 5s, so if you’re 
in the market for a new 4in smartphone then 
this is a very good choice. While the lack of 3D 
Touch, a barometer, second‑generation Touch ID 
or a 128GB storage option are all irritants, that’s 
a combination that will be enough to convince 
a lot of Apple fans. Essentially, it’s good. For 
those that need it. Lewis Painter

Specifications
•  iOS 9.3
•  4in (1136x640, 326ppi) Retina display
•  A9 chip with 64‑bit architecture
•  Embedded M9 motion coprocessor
•  12Mp iSight camera with 1.22µ pixels
•  4K video recording (3840x2160) at 30fps
•  1080p HD video recording at 30‑ or 60fps
•  720p HD video recording at 30fps
•  1.2Mp FaceTime camera
•  Touch ID
•  Apple Pay
•  GPS and GLONASS
•  Digital compass
•  Wi‑Fi
•  Built‑in rechargeable lithium‑ion battery
•  Nano‑SIM
•  123.8x58.6x7.6mm
•  113g
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 The Night Shift feature in iOS 9.3 lets you 
adjust the colour temperature of the display, 
shifting away from blue spectrums of light, in 

the putative interest of improving sleep. But Apple 
makes no promises. On its website, Apple notes, 
“Many studies have shown that exposure to bright 
blue light in the evening can affect your circadian 
rhythms and make it harder to fall asleep.” In iOS, 
the feature is explained with “This may help you get 
a better night’s sleep.”

Glenn Fleishman reveals why it may not help you sleep

Feature:  
iOS 9.3’s Night Shift
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In fact, this feature likely will have little or no 
effect on most people. Apple hasn’t misrepresented 
any of the science, but clinical work done to date 
doesn’t point a finger right at mobile devices or 
even larger displays. Night Shift also can’t remove 
enough blue to make a difference if that colour is 
the culprit. And blue light may not be the trigger 
it’s been identified as. While researchers haven’t 
tested the new feature yet, several factors add 
up to at best a placebo effect and a reminder to 
power yourself down.

Apple might have done better to create 
something called Night Safe, an option that would 
countdown the moments until you’d be locked 
out of your hardware till morning except for 
emergencies or going through a tedious override 
process – a Do Not Disturb on reverse steroids.

Jumping to the chase, if you’re ready to 
crash: If you want to sleep better, the almost 
universal suggestion from both sleep and 
lighting researchers is to turn off any screen two 
hours before your planned bedtime. Some also 
recommend using warmer lighting throughout your 
house in sources you use in the later evening.

Why do you feel blue?
Our circadian rhythm, a biological cycle, 
regulates how our body functions and repairs 
itself, although it’s commonly associated with 
sleep and wakefulness. It’s roughly 24 hours for 
human beings, and our bodies use a number of 
cues to keep us on track. Getting out of sync can 
contribute to illness), obesity, diabetes, and even 
an increased risk of cancer.
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Researchers have conducted studies over 
decades that isolate people from external cues 
to see what a natural cycle looks like, and how 
we sleep and wake. More recently, a lot of clinical 
and survey work has looked into measuring the 
effect of lighting: cycles of light and dark, light 
temperature, brightness, and other factors.

A discovery about 20 years ago helped make a 
connection, the limits of which are still being felt 
out. Many animals, including humans, produce the 
hormone melatonin across the circadian cycle, 
but it’s suppressed to low levels during natural 
waking hours. As it gets dark, that suppression 
abates, and melatonin production helps us 
become sleepy and remain asleep. (It has many 
other attributes, too, and other hormones have 
cycles that seem less tied to sleep.)

Melatonin production starts ramping up about 
two hours before your body’s natural sleep cycle 
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would start – often described in research as about 
10pm. And it’s produced in the largest quantities in 
the wee hours, wherever in the world you are, right 
in the middle of what your body perceives as the 
darkest time of day.

If you want to sleep better, the almost 
universal suggestion from both sleep and lighting 
researchers is to turn off any screen two hours 
before your planned bedtime.

Since this light receptor type was discovered, 
scientists have connected in many, many studies 
not just light and melatonin suppression, but 
specifically light that’s heavy on blue frequencies. 
Blue light can ostensibly offset the cycle of 
hormone production by a couple of hours or 
more. This has led to speculation that staring at 
television sets, monitors, and mobile displays 
disrupts or delays sleep. If you have to get up or 
are woken up at a fixed time, as for most people, 
this both reduces sleep and throws off the body’s 
endocrine and other systems.

Daylight has a large proportion of short‑
wavelength light at the blue end of the spectrum 
(around 460 nanometers). Indoor lightning has 
been traditionally ‘warmer’, or towards the yellow, 
longer‑wavelength end (about 555nm) or red at 
the far end (650nm). That’s true of fire and most 
incandescent lighting.

But a shift in lighting over decades has 
shifted towards cool, ‘white’, or ‘daylight’ 
illumination, whether incandescent, fluorescent, 
or LED. While thought of as whiter, they actually 
produce bluer light, resembling more closely our 
perception of a sunlit day.
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This description of colour gets labelled colour 
temperature, and is measured in kelvins (K). 
On one end of the spectrum, you have red/
yellow candlelight at 1,000K, considered very 
warm; at the other end, pure blue sky is 10,000K, 
considered very cool. Most LCD monitors and 
mobile displays can calibrate against a standard 
called D65, which centres at 6500K, blue and 
cool – it’s described as outdoor daylight at noon. 
Many displays are tuned or default to a higher 
temperature, though, and are much bluer.

Specific research and reasonable speculation 
centres around how predominantly blue light 
from television sets, computer monitors, laptop 
displays, and mobile screens might be connected 
with the increase of a host of ailments in nations in 
which a large percentage of residents use those 
technologies before and at bedtime.

Of special interest is the simple lack of 
sleep. The Center for Disease Control and 
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Prevention estimates 50 to 70 million US 
adults have disorders that prevent them from 
sleeping sufficiently to be alert, productive, and 
rested on an average day.

All the discussion of blue light has led to 
programs and extensions for many computer 
platforms that attempt to reduce the production 
of blue light in order to avert circadian rhythm 
disruption. The f.lux software ( justgetflux.com) is a 
well‑known example, available for OS X, Windows, 
Linux, and rooted Android phones. (It could be 
installed through a workaround in iOS, until Apple 
asked f.lux to stop distributing it.)

iOS’s Night Shift is just the latest entrant for 
colour‑temperature shifting, albeit making it 
available to roughly 500 million devices via iOS 
9.3. Only devices released starting in about 
2013 have hardware that supports the feature, 
according to Apple’s feature notes.

But the big problem is that there’s no solid 
evidence that mobile screens’ colour temperature 
is the real culprit, nor whether devices and 
monitors can shift enough to matter if they were 
– or even if blue light on its own is the trigger.

Blue meanings
While exposure to colours of light has been well 
researched, it’s not entirely clear that merely 
seeing light heavy in the blue part of the rainbow 
is the trigger – or at least the sole trigger. It 
may be that a shift in colour in the hours around 
twilight, which comes with a change from blue to 
yellow, could be a more significant marker. Blue 
may be a red herring.
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It might also be the intensity of light or the 
proportion of the visual field it occupies. A large, 
bright screen that’s far away could have as little or 
the same effect as a small, bright screen close up. 
Many of the studies until recently used full‑room 
illumination or specifically‑tuned light sources 
(like panels used to treat seasonal affective 
disorder), and have taken place in highly controlled 
laboratory environments that block all other 
light. Because of the cost and complexity of the 
experiments, the most rigidly constructed ones 
often involve only a dozen or so individuals who 
spend several days under observation.

In terms of size and brightness, it’s more likely 
that an effect on melatonin production would come 
from adjusting an iPad Pro than an iPhone of any 
size, due to light and intensity of light produced.

Mariana G. Figueiro, a professor at Rensselaer 
Polytechnic Institute and the program director of 
its Lighting Research Center (lrc.rpi.edu), says her 
group has used precise measurements of light 
sources and displays to calculate predicted effects 
and performed clinical testing to test outcomes.

She notes there’s a huge variation between 
an iPhone, a tablet, and large‑screen televisions. 
“People tend to have a misconception that because 
it looks bright, because your visual system is so 
sensitive, that it is affecting your melatonin,” she 
says. Her work and that of others has shown that 
you “can still suppress melatonin with a warm 
colour if it’s a high light level.”

Even what’s being displayed matters. Dr. Figueiro 
says a Facebook page with a white background 
and mostly text produces more light than the same 
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page viewed with white on black text. Although 
she hasn’t tested Night Shift yet, she says that in 
terms of size and brightness, it’s more likely that an 
effect on melatonin production would come from 
adjusting an iPad Pro than an iPhone of any size, 
due to light and intensity of light produced.

But beyond the variation, there’s the degree 
of blue removal. Ray Soneira, the president 
of DisplayMate, a company that makes video‑
diagnostic hardware and software, says that Night 
Shift and related software doesn’t turn down blue 
spectra in the correct range enough, thus not 
providing assistance even if true.

In the case of Night Shift and similar systems, 
he argues that the blue component would need 
to be entirely removed or reduced significantly 
more than the systems offer, which in turn would 
make the display too yellow for most people. He 
writes, “Just slightly reducing the blue, which is 
what most apps do, won’t accomplish much, so 
the improvements people experience are often 
mostly due to placebo and their own conscious 
modification of their behaviour in using displays.”

In any case, Dr. Figueiro says sleep research 
shows there’s an extremely important and often 
overlooked factor that requires more discipline 
than an automatic colour‑temperature adjustment. 
“Disruption of sleep is not just melatonin 
suppression; it’s what you’re doing to your brain 
to keep it alert,” she says. She recommends 
turning off all your screens two hours before 
going to bed. “These programs help, but they 
don’t completely remove the possibility of 
suppressing melatonin.”
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 Kodi is a free, open‑source media player. 
Kodi started off on the Xbox, where it was 
known as Xbox Media Center (or XBMC). 

The software is now available on a range of 
platforms and in more than 65 languages, and 
incorporates the work of hundreds of programmers. 
And it’s now known as Kodi, of course.

A non‑profit called the XBMC Foundation  
(tinyurl.com/zvqujcr) operates the project, and the 
work is done by volunteer programmers around 
the world, who are known as Team Kodi. Team 
Kodi foot soldiers can join the Foundation, and – if 

David Price looks at the open‑source media player software

Feature: What is  
Kodi and how to get it
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successfully elected – members of the Foundation 
can join the XBMC Board of Directors.

You can also use Kodi to play video on an iPad 
or iPhone ‑ just not officially, since the software 
isn’t available on the App Store. Instead, the most 
common approach is to download it from the Cydia 
software store, but this strategy obviously only 
works on devices that are jailbroken.

Many, many owners of iPhones and iPads have 
jailbroken devices without suffering any ill effects, 
but there remain several reasons why you might 
not want to jailbreak. Your device is more likely 
to behave in unexpected ways; it’s vastly easier 
to download malicious software (although you 
should still be okay if you’re careful); and Apple 
may refuse to help you with a misbehaving device 
if they discover that it’s been jailbroken. After all, 
you went against their advice.

(It’s possible to ‘unjailbreak’ a device, mind you, 
a process which might come in handy if you need 
to visit the Genius bar. Here’s our tutorial explaining 
how to unjailbreak an iPhone or iPad.)

Happily, if you want to install Kodi on an 
unjailbroken iPhone or iPad, you can.

Get Kodi on iPhone or iPad
Before we start, you’ll need to download three 
things, but one of them could take a little while, 
so sort this first. You need the Kodi deb file from 
tinyurl.com/pnalp3u. We used version 15.2.1 in 
our walkthrough. You also need iOS App Signer 
(tinyurl.com/z3gf7wq) – click ‘Download r17’, then 
unzip the file. (You may see an adunderneath for 
a different download but if you hover over the link 
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you’ll see it’s for something else.) Finally, you need 
to install Xcode 7 from the Mac App Store if you 
haven’t got it already. (Xcode is free.)

Once you’ve got the first one saved to your 
desktop, and the others installed on your Mac, 
we can get started.

1. Plug your iPad or iPhone into your Mac and 
open Xcode.

2. Select ‘Create a new Xcode project’. Make 
sure Application is highlighted in the iOS section 
on the left, and then click on Single View 
Application. Hit Next.

3. In the next dialogue box you need to identify the 
application you’re creating. Fill in Product Name 
(we’d suggest Kodi) and Organisation Identifier 
(which should be something unique – I went with 
com.DavidPrice). The other fields should be filled in 
already, and you can leave the options as they are. 
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You could choose to make the app specifically iPad 
or iPhone at this point but we might as well leave it 
as Universal. Hit Next.

4. On the next box, choose a location for your 
Git repository. We just saved it on the desktop. 
Click Create.

5. Don’t allow Xcode to access your contacts. Or 
do, if you want. We said no, but we don’t think it 
makes a difference.

6. In the middle of the Xcode screen you’ll see 
an unobtrusive error message: ‘No code signing 
identities found’. Click Fix Issue underneath this 
message, then Add… on the next dialogue box. 
Enter your Apple ID and sign in.

7. Go back to the main screen and you’ll see a 
message: “To fix this issue, select a Development 
Team to use for provisioning”. There should only 
be one ‘Development Team’ to choose from, 
so go ahead and click Choose. Xcode will say 
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it’s resolving the issues, and after a short wait 
everything should be fixed.

8. Open App Signer – just double‑click the icon that 
you saved to your desktop when you unzipped the 
download. Where it says Input File, you want the 
Kodi deb file we downloaded earlier: click Browse, 
find the file on your desktop (or wherever else you 
saved it) and click Open. Signing Certificate should 
be filled in already (this should contain your Apple 
ID); for Provisioning Profile, select the profile with 
the identifier we set in Step 3. New Application 
ID will be filled in, but we added Kodi as an App 
Display Name (this is what will appear on your 
Home screen). Click Start.

9. Choose a file name for the Save As field – again, 
you can just go with the suggestion, provided you’ll 
be able to remember it – and a location. Click Save. 
App Signer will unpack the data and save the file; 
it’ll say Done (at the bottom of the tab – you don’t 
get a separate message) when it’s finished.

10. We’re nearly there. Go back into Xcode and 
select Window > Devices. Click on your iOS device 
in the lefthand pane. At the bottom of the righthand 
pane containing your iPhone or iPad’s details – you 
may have to scroll down to see it – is a small plus 
sign. Click this. (There’s a plus sign at the bottom 
of the lefthand pane too, and this is more easily 
visible. But you want the one on the right.)

Find and select the .ipa file that iOS App Signer 
generated in Step 9, and click Open. After a short 
pause while it installs the app (maybe 10‑ to 15 
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seconds in our experience) you’ll see the Kodi app 
listed under Installed Apps.

11. Unplug your iOS device and unlock it. You’ll see 
the Kodi icon in the first available space on your 
device. Depending on your settings, there’s a good 
chance that you’ll get an ‘Untrusted Developer’ 
error message when you first tap the icon, and 
you’ll only be able to tap Cancel.

So tap Cancel (or just don’t try to start the app 
yet), and instead go to Settings > General, and 
scroll down to, and tap, Device Management (it’s 
near the bottom of the list). Under DEVELOPER 
APP, tap on the account you used earlier in 
the process, then on the next screen, tap Trust 
“[name of account]”. Then tap Trust again.

12. That’s it! Go back to the your Home screen 
and tap the icon to run the app.

That’s the process as we followed it, 
and everything worked perfectly for us. But 
DanTheMan827 adds some optional extra 
steps that you may wish to follow “if you want a 
working tvOS top shelf”. Insert these extra steps 
between Steps 7 and 8:

i. Go to the Capabilities tab and turn on App Groups

ii. Add a new group with the format of group 
where is the full app id entered earlier (such as 
group.com.DanTheMan827.Kodi)

iii. Click fix issue 
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Why your base station and OS  
X might report different Wi-Fi rates
Rich Knudson wants to know why his 802.11ac‑
bearing iMac from late 2015 isn’t giving him the 
performance he expects when connected to a 
new Time Capsule, which also has 802.11ac Wi‑Fi 

Glenn Fleishman answers your Mac questions

Feature: Help desk
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networking. He compared AirPort Utility numbers to 
OS X’s hidden display, and writes:“The data rate/Tx 
[transmit] Rate and RSSI [received signal strength] 
are very different between Airport Utility and the 
extended Wi‑Fi data you get when you option click 
the Wi‑Fi icon in the top right menu bar. One of the 
benefits I was expecting with my new setup was to 
connect my iMac to the network using wireless‑ac 
and see a step function improvement in data rate/
Tx Rate speeds.”

A: As someone who has tested and used Wi‑Fi 
for 15 years, I was curious about this, too. It’s true 
that a Wi‑Fi adaptor and a Wi‑Fi base station have 
asymmetrical parameters. The Wi‑Fi adaptor in 
a mobile or desktop device almost always has a 
less‑powerful radio and antenna arrangement for 
reasons of size and battery. (Desktop Macs can use 
more power, but they’re relying on similar designs.) 
A base station can produce a much stronger 
signal and its antenna arrangement has a design 
optimised for reach and performance; it doesn’t 
have to play nice with computer or handheld 
functions, like an adaptor does.

So it’s very likely you’ll see an adaptor report 
stronger signal strength from the base station 
than the base station will report for the adaptor. 
A base station can push out more power in a 
focused direction, allowing a distant receiver to 
pick up a signal, and it can also have more receive 
sensitivity, allowing a faint transmission by the 
adaptor to be heard clearly.

But other reported values should be the same: 
If you’re looking around the same moment, the 
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data rate should be identical, 
as that’s a function of the 
negotiated connection between 
adaptor and base station. 
Wi‑Fi in all its flavours allows 
devices to move to faster and 
slower rates as performance 
improves or degrades. This 
allows you to move closer to 
or farther from a base station 
and maintain a connection. 
The 802.11n and 802.11ac 
flavours can also use variable 
amounts of frequency – different 
channel ‘widths’ – based on 

the active electromagnetic environment in the 
ranges they’re employing. Over very, very short 
intervals, from one frame to the next (the wireless 
data equivalent of a packet), raw throughput could 
vary by a factor of four.

If you want to check your own values, it’s very 
straightforward. In OS X, hold down the Option 
key and click the Wi‑Fi icon (as Rich notes) and 
you’ll see detailed diagnostic and performance 
information. In AirPort Utility 6, click a base station 
and hover over any entry in the Wireless Clients 
list to reveal connection details. (You can also 
hold down the Alt key and click Edit, and in the 
now‑revealed Summary tab, you can click the 
expand triangle in the Wireless Clients list to 
see details as well.)

I asked Apple about this situation, as it seemed 
like there were disparities. It replied that because 
Wi‑Fi environment changes constantly, the values 
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represent essentially a snapshot of a sliver of 
time – if the snapshot in OS X and AirPort Utility 
aren’t the identical moment (probably down to 
milliseconds), the details will vary slightly. AirPort 
Utility only refreshes after launch if you press 
Command‑R, then new values are loaded.

Rich sent screen captures showing that the 
base station thought it was connected at a rate 
of 351Mb/s, while his Mac said 117Mb/s. That’s 
obviously a threefold difference, but because of 
constant rate changes, it’s within expected ranges.

To get a better sense of network hotspots and 
performance, you can use tools such as Wi‑Fi 
Explorer (£10.99, tinyurl.com/kq9yp38) and NetSpot 
(free, tinyurl.com/q9wj4jc). And if you’d like to 
check actual throughput, instead of reported 
network speeds, jperf is your best bet. It requires 
the installation of Java, but not in a web browser, 
so you’re not exposing your self to web‑based or 
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remote attacks. You install jperf on a target Mac 
connected via ethernet to the base station, and 
then on a Mac connected by Wi‑Fi. You can then 
set one as a server and one as a client to run tests.

Separate iPhone  
pictures in Photos for OS X
Q: Can I search for photos taken with iPhone in 
my Photos library? I’ve got over 13,000 photos 
that I’ve tried to keep organised and export them 
to an external drive so that I can vacate space on 
my hard drive, but want to keep the low-quality 
iPhone photos separate.

Jenni Kapanen

A: Yes, you’re in luck. I feel like the Smart Album 
feature in Photos (as in iPhoto) has a lot of 
overlooked power. Here’s a great case.

Start by choosing File > New Smart Album. Now 
you can select criteria. While there are some iPhoto 
elements missing from Photos for OS X (notably 
related to whether any face has been set in a 
picture), you can still create complicated chained 
or independent queries.

For instance, for your purposes, you could 
create two smart albums: One would look for all 
photos taken by cameras that aren’t iPhones; the 
other could be only pictures taken by iPhones. 
This would let you separately browse through 
both categories. (Unfortunately, you can’t create 
a smart album and then create a separate one 
that’s its inverse selection.)

Let’s say I want an album that only contains 
photos (not videos) taken by any iPhone model. 
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In the New Smart Album dialog, I’d choose All from 
the Match menu, as I have two criteria. My first is 
Camera Model set to Starts With and then iPhone. 
(I could also select Is and pick specific iPhone 
models in the list.)

Then I’d click the + to add another criterion, and 
choose Photo, set matching to Is Not, and choose 
Movie from the category pop‑up menu. After 
clicking OK, and I’d now see only images taken 
by any iPhone I’ve ever owned.

These criteria can be useful, too, if you’re trying 
to sort or find images taken with more particular 
photographic parameters. If you want only shots 
at ISO 100 taken at f/2.2, you can do that, too. Or, 
only pictures in a certain date range that were 
taken without a flash.

Can you merge synced  
data from multiple Apple IDs?
Q: One thing that I don’t fully understand is 
why iCloud can’t be used as a solution to this 
problem? Would it be possible for me to set 
up a new, third Apple ID and to sync both 
existing accounts to it and then delete them 
and implement the new, third Apple ID on all my 
devices? Everything is in sync (which is why I 
haven’t moved to using just one Apple ID before 
now). If I add a new contact on my iPhone, it pops 
up on my iMac. Likewise with Calendar entries. 
Also, the 385 physical CDs that I’ve uploaded to 
iTunes on my iMac are also there on my iPhone 
and music I’ve purchased from iTunes on my 
iPhone are also on my iMac.

Dara Hogan
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A: Dara has a problem that a lot of readers share: 
two Apple IDs that are both used for iTunes and 
iCloud. Dara also notes because everything is 
in sync she would rather stay put, which is a 
common one for many, and is the reason that I 
continue to use an older Apple ID for iTunes and 
a newer one for iCloud.

So here’s the problem. You can’t migrate 
anything among Apple IDs using iCloud or other 
tools, nor migrate your email. You could make 
sure one Mac (better than iOS for this purpose) 
was up to date with contacts and calendars, and 
you’d use Mail or another IMAP‑supported mail 
client to download all email that was stored on 
the server to local storage.
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If you used iCloud Photo Library or iCloud 
Music Library or iTunes Match, you’d want to be 
sure that 100 percent of the synced material is 
stored locally on the Mac, too. (In iCloud Photo 
Library, set the iCloud preferences to download 
full‑resolution images. With iTunes, you can 
search for song files stored in the cloud through 
a Smart Album, then select and download all 
of them.) You’d also need to make sure you’d 
cleared out iCloud Drive of any files you need.

Then you could disable iCloud and be 
sure to click every dialog that asks that you 
want to keep information stored locally. Now, 
you can create a new Apple ID you plan to 
use with iCloud synchronization and enable 
synchronization for all the services.

However, a lot of provisos:

•  All DRM‑protected media purchases and all Mac 
App Store and iOS apps remain locked to the 
accounts through which they were originally 
purchased. 

•  If you want to keep using one of the emails 
associated with your other Apple IDs – 
especially to send email using that address as 
the return address – you need to keep an entry 
in your mail programs for it. 

•  There may be Apple‑associated or third‑party 
connections to the Apple IDs or associated email 
addresses, so you may regularly have to log in or 
enter passwords in any case.

If that all works for you, then a third Apple ID 
should work out just fine.
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Of course, the real solution here is for Apple 
to act like a company doing business in 2016 and 
build Apple ID migration and merge options that 
preserve media ownership and transfer the licenses 
and consolidate previous purchase histories and 
other records. Many, many, many companies do 
this, and some have tens of millions of customers, 
too. Until that happens, everything else is a second‑
best measure. 

Can you use Wi-Fi and  
ethernet on a Mac at the same time?
Q: I have an ethernet connection to my FiOS 
modem/router and it works great. Somewhere 
along the line I had to turn on my Wi-Fi as 
well. Don’t remember why. Just curious, is it a 
benefit or a deficit or is it neutral to have both 
connections active at the same time? 

Don Smith

A: Don (and Don really exists, I didn’t invent him, 
I swear), that’s 
a great area to 
discuss. OS X is 
a well‑designed 
modern operating 
system that for 
many releases 
has let you 
have multiple 
active network 
interfaces. They 
can be ‘real’ in the 
sense of directly 
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corresponding to physical hardware that’s part 
of or attached to a Mac, or ‘virtual’, as is the case 
with VPNs (virtual private networks).

Typically, they won’t conflict, even if you have 
two or more interfaces connected to the same 
network, such as Wi‑Fi and ethernet. A few 
years ago, OS X would balk at this; but since 
Mavericks (10.9), I’ve kept both active. (You may 
want Wi‑Fi active at all times so you can take 
advantage of Continuity features that require 
Wi‑Fi, and to use AirDrop.)

OS X automatically sorts network interfaces in 
the Network system preferences pane in the order 
of first ‘connected’ interfaces (ones with an active 
signal and IP address), then disconnected ones, 
and finally those marked inactive. (You can select 
any interface, click the gear icon, and choose Make 
Service Inactive to disable it.)

But you can choose the order in which OS X 
accesses your local network and the Internet. 
Click the gear icon and then select Set Service 
Order, and you can drag interfaces around in the 
priority you want OS X to use them when they’re 
available and connected.

The most likely scenario for this is cascading 
an ethernet, Wi‑Fi, and iPhone USB connection 
with a laptop. When you’re plugged into ethernet, 
you don’t want to have to turn off Wi‑Fi, so you 
set ethernet as the first item in the Service Order. 
Likewise, if you’ve unplugged from ethernet, 
you’d prefer Wi‑Fi, but if that’s not available either, 
you want to use your iPhone’s hotspot. Setting 
this order means no mucking about when your 
network conditions change. 
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 New games come out pretty frequently for 
the Apple TV, and while there are thankfully 
more games that work well with the Siri 

Remote, there are also many that just cry out for 
a dedicated gamepad. Many of these are console 
favourites – or console‑inspired games – that just 

Sit back and relax with Andrew Hayward’s top games

Round up:  
Apple TV games
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aren’t meant for a small touchpad, and a gamepad 
goes a long way toward making your Apple TV 
feel like a proper gaming machine.

Included here are 12 of our favourite Apple TV 
games that are best experienced with a gamepad, 
but we’re not claiming that each individual game 
warrants an investment in extra hardware. Rather, 
collectively, they show how much widespread 
benefit you’ll get from a controller, and why it’s 
a crucial pickup if you have plenty of Apple TV 
sofa gaming in your future. And if you’re looking 
for MFi (Made for iOS) gamepad recommendations, 
we have those as well.
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1. Geometry Wars 3: Dimensions Evolved
Activision’s Geometry Wars is one of the greatest 
dual analog stick showcases ever created, 
delivering effortlessly (and endlessly) amusing 
arcade shooting with one stick for movement and 
the other for firing. Sadly, it doesn’t convert too 
well to the Siri Remote: Automating firing makes 
it more manageable, but the tiny touchpad makes 
movement feel too fidgety. 

Add in a gamepad, however, and Geometry 
Wars 3: Dimensions Evolved (£7.99) is every bit 
as brilliant as it is on Xbox and other consoles, 
with precise and challenging combat that will 
keep you coming back to improve your high 
scores. And Dimensions Evolved is absolutely 
packed with content, including a campaign and 
the classic arcade modes of earlier entries.
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2. Zen Pinball
Why would video game pinball need a full 
gamepad? Zen Pinball (free) is worth experiencing 
either way, but swiping the Siri Remote’s touchpad 
just doesn’t give you that satisfying click of 
frantically jamming a paddle button. Grab a 
gamepad and you can flick the triggers to bat the 
digital ball around the dozens of available boards. 

Zen Pinball is excellent on the iPhone and 
iPad, and it’s even better on the Apple TV, with 
the same large library of original and licensed 
tables available to purchase. You get one table 
free, with others – including many Marvel, Star 
Wars and South Park ones – sold for £1.49 apiece 
with unlimited play. Buttons just feel a lot more 
responsive here than Siri Remote swipes.

MWJUNE16.indd   88 19/05/2016   12:36



JUNE 2016 • MACWORLD  89

3. Octodad: Dadliest Catch
Octodad: Dadliest Catch (£3.99) is like nothing 
you’ve ever played before, in part because it’s a 
game about hiding out in suburbia as an octopus 
amidst an unaware human family. It’s also unique 
because to nail that “simulation,” the developers 
made the game intentionally cumbersome, which is 
a tricky approach for a game you’re meant to enjoy. 

While solidly playable with the Siri Remote, 
Octodad is a lot more fun with a gamepad, as 
it removes the frustration of needing to switch 
between upper tentacles (for grabbing things) 
and lower ones (for walking). Octodad is worth 
experiencing on any device you have, including an 
iPhone or iPad, but this former console game really 
shines on a big screen with a gamepad.
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4. Modern Combat 5: Blackout
Spend a couple minutes with Modern Combat 5: 
Blackout (free, plus in‑app purchases) using a Siri 
Remote and you’ll quickly learn that they really, 
really aren’t meant to be together. Gameloft’s 
first‑person shooter automates player movement 
when using the Siri Remote, but the resulting 
experience is incredibly awkward and really not 
worth the hassle.

Luckily, a gamepad solves all problems here: 
Modern Combat 5 emulates the Call of Duty 
console game template, and it feels right at home 
with analog sticks and triggers. The quick‑hit 
missions are solid fun, and the multiplayer combat 
is a delight if you can find enough players to face 
off against. And it’s free, albeit with an energy 
system and paid perks to contend with.
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5. Transistor
Transistor (£7.99) was one of the first big games 
available for the Apple TV, and it’s clear that a lot 
of work went into making it fit on the Siri Remote. 
Through some clever streamlining and configuring, 
it’s relatively easy to experience this dazzling sci‑
fi adventure with just the Siri Remote, although 
jamming a lot of commands onto the tiny device 
can make things feel cramped.

And that’s where a gamepad provides some 
welcome breathing room. Transistor was originally 
designed for a proper controller, and with it, you’ll 
have sharper control of heroine Red and be more 
comfortably able to interact with and explore the 
city. It’s not only a big‑screen showcase, but also 
a nicely meaty quest, so this is one well worth 
enjoying with a gamepad.
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6. Real Racing 3
Real Racing 3 (free, plus in‑app purchases) is the 
best simulation‑style racing game on iOS, and it’s 
much the same on the Apple TV, delivering loads 
of licensed cars and numerous real‑life tracks to 
zip around – and it looks really sharp on the big 
screen. The Siri Remote’s tilt controls work solidly 
for steering, and if you’re only playing casually, 
it’ll do the trick. 

Switching to a gamepad makes it feel much more 
like a console‑like simulation, however, offering 
more precise steering and better control over 
acceleration and braking. Real Racing 3 scales well 
between those two experiences, but it’s especially 
great with a gamepad, and really gives the Apple 
TV some console gaming cred in the process.
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7. Disney Infinity: 3.0 Edition
This one requires some explanation. You’ll need 
the Disney Infinity: 3.0 Edition starter pack to play 
the full game, and it actually comes with the great 
SteelSeries Nimbus controller. It’s also priced at 
£99 as of this writing, but the gamepad itself would 
be £39. So what do you get?

Well, you get a full‑fledged Star Wars console 
game, along with two smart chip – equipped 
figurines and a Bluetooth base that pulls those 
characters into the game. You can also add on new 
Star Wars, Marvel, and Disney adventures, and 
use a wide array of Infinity figurines in the Toy Box 
mode to create and share your own little games 
and worlds. It’s a big, exciting game, and well 
worth the investment if you love Disney’s myriad 
properties. And if you’re planning on buying the 
Nimbus anyway, this is a perfect way to do so.
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8. Oceanhorn
Meanwhile, if you want a game that looks and plays 
like a big console adventure, but lacks the heft, 
extra plastic, and big price tag of something like 
Disney Infinity, give a strong look to Oceanhorn 
(£6.99). This iOS original is strongly modelled 
after Nintendo’s Legend of Zelda series, but the 
action role‑player deftly avoids feeling like a 
half‑hearted clone. 

The Siri Remote’s touchpad isn’t the best 
option for 3D character movement, as it can feel 
a bit confined, although Oceanhorn does a fair 
job of making this adventure playable with your 
thumb alone. Switch to a gamepad, however, 
and Oceanhorn better resembles the classic 
games it emulates, giving you precise control 
of your hero on land and at sea.
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9. Skylanders Superchargers
The most ideal way to play Skylanders 
Superchargers (free, plus in‑app purchases) is to 
buy the starter kit, which sells for £54 and comes 
with a couple of smart toys, a Bluetooth portal, and 
a small gamepad that only works with Skylanders. 
But if you already have an Apple TV gamepad – 
and/or you don’t want all that expense – you can 
just download the app and buy the content within. 

The full Superchargers game is sold as a £14.99 
in‑app purchase, and that gets you a full‑fledged 
console action game, complete with on‑foot beat‑
’em‑up action and various vehicle missions that let 
you race and fly. And the free initial download lets 
you try out the game before you consider shelling 
out for more. Like Disney Infinity, it offers up a fun, 
kid‑friendly adventure and really makes your little 
set‑top box seem like a proper game console.
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10. AG Drive
Many iOS games have tried to replicate the intense 
fun of anti‑gravity racing classics like F‑Zero and 
Wipeout, but AG Drive (£2.99) is the only one that 
deserves to be mentioned in the same breath as 
those greats – and it’s on the Apple TV, as well. It 
looks fantastic and has thumping techno beats to 
match, and like Real Racing 3, there’s a precision 
upgrade to using a gamepad. 

AG Drive has you hold the Siri Remote sideways 
and keep your thumb on the touchpad, sliding in 
either direction to whip around the wild curves. 
This works well enough, but using an analogue 
stick makes steering feel so much smoother and 
gives you more command on the track. And AG 
Drive isn’t an easy game, so every little bit of 
added control helps.
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11. Duck Tales: Remastered
Duck Tales is a proper old‑school game from the 
8‑bit era, which means it doesn’t really have a 
use for analog sticks and trigger buttons – but 
even a relatively simplistic 2D platformer isn’t 
best experienced with the Siri Remote. It’s solid 
enough, with the touchpad used for movement 
and all other actions mapped to the play/pause 
button, but that scheme sacrifices some fluidity 
of movement and action. 

Meanwhile, a gamepad has a directional pad and 
at least a couple of dedicated buttons for jumping 
and using Scrooge McDuck’s cane as a pogo stick 
or weapon, which make this updated classic a 
lot more enjoyable. And Duck Tales: Remastered 
(£7.99) has crisp, redone graphics that look really 
superb on a TV screen.
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12. Xenowerk
Like Geometry Wars 3, Xenowerk ( £1.49) is an 
arcade‑style game built for analog sticks, as you 
guide a gun‑toting heroine through alien‑infested 
facilities. But unlike Geometry Wars 3, I wouldn’t 
try to play Xenowerk with the Siri Remote for 
more than a couple minutes. The scheme is very 
awkward, and it honestly takes away from the 
tension and excitement of the game.

Luckily, this is a very fun little shooter to 
experience if you do have a gamepad, as the 
twin‑stick controls work well for movement and 
blasting, and there’s a visceral thrill to the combat. 
It can be repetitive, but it’s very easy to get your 
couple bucks of fun out of Xenowerk.
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 We received an email from Thomas Staton, 
asking about backup strategies:

“Since I have two backup drives, should I use 
Time Machine on both, or use cloning hardware 
on one and Time Machine on the other?

I’m a great fan of belt, suspenders, duct tape, 
and a spare belt. Time Machine and clones have 

Glenn Fleishmann looks at your different options

How to: Set up a 
redundant backup system
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different purposes, though you can use them 
to the same end in the right case. If you have a 
non‑recoverable drive failure, you can either use 
a clone or a Time Machine drive to restore to the 
last backed up point.

Time Machine’s advantage is twofold in the 
right case. First, it’s routinely backing up, so 
even as you work, some files are being written in 
backup form. Secondly, it has archives of previous 
versions of the same files.

However, using two drives as Time Machine 
destination provides redundancy in case one fails, 
but it doesn’t provide diversity. If something goes 
wrong with one Time Machine backup, it’s possible 
the other would be corrupted for the same reason. 
And you’re not getting enough differential between 

Time Machine
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them to have a more recent restore point, either, 
even if both work perfectly.

Cloning with something like Carbon Copy 
Cloner (bombich.com) or SuperDuper (tinyurl.
com/6krpz) typically happens on a schedule, so 
you won’t have the latest version of a dead drive, 
but one that could be several hours out of date. 
Standard cloning software doesn’t archive older 
file versions, either.

However, because I store email remotely, 
and use Dropbox and other synchronized data 
tools, I’m more concerned with getting back to 
work faster than I am having an up‑to‑the‑minute 
(or ‑hour) restore point of everything. Dropbox 
will resync after I restore.

I like the flexibility of a clone because Time 
Machine can be fussy and sometimes restores 
will fail for no diagnosable reason. I prefer using 

Carbon Copy Cloner
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Time Machine to restore older file versions, and 
clones to restore entire drives. This is especially 
easy when the clone is written to a volume as 
a sparse disk image, which can be mounted 
by Disk Utility from OS X Recovery. Last year, I 
had a recent clone on hand after a drive failure 
(which I’d made partly because I thought the 
drive was nearing death), and was able to boot 
into OS X Recovery, select the disk image from 
an external mounted drive, and write that to my 
new drive, and then boot from it.

Beyond the above, I strongly recommend you 
keep a recent backup, preferably in encrypted 
form, somewhere else. With two drives, you might 
use Time Machine as your regular backup, and 
cycle in the second drive from another location or 
a safe‑deposit box for regular clones. You could 
also buy an inexpensive third drive, one that’s 
USB‑bus powered for compactness, just for this 
purpose. Multi‑terabyte portable drives where 
you don’t need high performance for use as an 
active drive are pretty cheap.

I also recommend having some form of hosted 
online backup, so that in the event of total 
destruction of your equipment, your files still live 
on in the ether. Backblaze (backblaze.com), for 
instance, lets you back up your files and lock 
the encryption key with a passphrase that they 
never have access to, making you the only weak 
leak in the encryption chain. Many who have few 
applications installed rely on cloud services, and 
use web apps and Google Drive or Dropbox to 
make sure they have the very latest versions of 
every document they’re working on.
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 While email is slowly being replaced by 
other forms of communication such as 
text messaging, or services such as 

Slack, it is still the main way people do business. 
The average user receives about 90 emails per 
day, a dozen of which are spam. To help work 
efficiently with email, it’s a good idea to filter some 
of your messages. You may want to have separate 
mailboxes for your work and personal emails, or 
specific mailboxes for emails from close friends. If 
you’re using email for business, you may want to 
filter emails by client, or put support emails in one 
mailbox, and sales queries in another.

Take control of your messages in OS X’s Mail, 
iCloud and Gmail. Kirk McElhearn shows how

How to: Filter email
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There are many ways to filter email: in some 
cases you can filter your email directly on a server, 
so filtered messages don’t go into your inbox at 
all, making it easier to deal with email on your iOS 
device. And you can filter email on your Mac, in 
your email program.

In this article, I’ll look at filtering email on iCloud 
and Gmail, two of the most popular email services, 
and explain how you can create filters in Mail. It’s 
easy to set up filters, and it can make your email 
life a lot easier.

Filtering in Mail
I’ll start with Mail on OS X, since, if you use this 
app, you’ll want to set up folders or mailboxes there 
that your server‑side filters will use as well. If you 
don’t have multiple mailboxes, create a new one by 
choosing Mailbox > New Mailbox. Select a location; 
if you choose On My Mac, you won’t be able to 
use filters on your server, so choose your email 
provider, such as iCloud or Gmail. (I won’t cover 
setting up filters with other email providers; check 
their documentation to find out how to do this.)

Click OK, and you’ll have a new mailbox 
both on the server and in Mail. You’ll be able to 
move messages there from within Mail, in the 
iOS Mail app, and on iCloud.com.

Choose Mail > Preferences, then click Rules. 
Click Add Rule and then give your rule a name. 
Choose something from the condition menu, such 
as From, To, Any Recipient, Date, and more, and 
enter the text you want to filter. This could be 
a keyword in the subject, or an email address, 
or a client’s name. Choose what to do with the 
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message; in the example, I’m moving messages 
sent to my iTunes Guy address to a specific folder. 
And then I add the condition Stop Evaluating 
Rules, so no other rules affect the message.

When you use filtering on your Mac, your email 
is filtered there as long as the Mac is running, and 
you’ve got Mail open. Even if you’re not home, if 
your Mac is on, Mail filters your messages, making 
it easier to deal with mail on your iOS device. You 
may not want to leave your Mac running all the 
time, but if your Mac supports Power Nap, you 
can let your Mac sleep, and it will check for new 
email from time to time, and filter it while doing 
so. To activate this, choose the Apple menu > 
System Preferences > Energy Saver, and then 
click Enable Power Nap.

Filtering on iCloud.com
To filter messages on iCloud.com, log into iCloud.
com on the web. Click on Mail, then click the gear 
icon at the bottom left of the page. Choose Rules, 
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and then Add A Rule. Choose a condition from 
the first menu. You can choose who a message 
is from, who it’s addressed to, Cc’d to, or you 
can have iCloud filter emails that contain specific 
words in the subject.

In the Then menu, you can tell iCloud to move 
the message to a folder, to the Trash, or forward 
it to another email address. For the first choice, 
you then select a folder; for the third option, you 
enter an email address for forwarding. Click Done, 
and iCloud will filter these messages on the server, 
placing them in the folder(s) you’ve selected.

The advantage to filtering email on the server is 
that your Mac doesn’t need to be running. When 
you check email on your iPhone or iPad, your 
inbox won’t be as cluttered. You can still access 
the filtered emails by checking specific folders 
in Mail on your iOS device, but your inbox won’t 
contain as many messages.
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Filtering on Gmail
If you use Gmail, you can also filter messages. 
Click the gear icon, then choose Settings. Click 
Filters and Blocked Addresses, and then click 
Create A New Filter. Enter the term you want to 
use in the appropriate field: From, To, Subject, 
Has The Words, and so on.

Click Create Filter With This Search, and then 
choose how you want messages matching this 
filter to be processed. Gmail gives you lots of 
options for this: the emails can be archived, 
marked as read, forwarded, deleted, and much 
more. Click Create Filter to save the filter.

As with iCloud, these server‑side filters act on 
messages before they get to your Mac or your 
iOS devices. This is useful if you want to keep 
your iPhone’s inbox from getting overloaded with 
messages you don’t need to see right away.

No matter which method you use, you’ll find that 
filtering your email can save you a lot of time, and 
keep your inbox less crowded. 
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 Many of the apps on your Mac have a 
toolbar; that’s the grey section at the 
top of the window that contains a number 

of buttons and, perhaps, a search field. You see 
this in Safari, Mail, the iWork apps (Pages, Numbers, 
Keynote), and even in the Finder. The buttons 
available in these toolbars let you quickly access 
some of the most common functions of their 
respective apps.

Kirk McElhearn reveals how tweaking the Finder  
toolbar can help you become more productive

How to: Save time with 
the Finder window toolbar
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Tweaking the Finder toolbar can help you 
become more productive. You can add buttons 
for functions you use often, ones that might be 
harder to access via menus. You can add a specific 
button that offers most of the same menu items as 
the Finder’s contextual menu; this is great if you’d 
rather click a button than right‑ or Control‑click. And 
you can use the Back and Forward buttons to move 
through windows or tabs you’ve viewed, and use 
the Finder view buttons to change Finder views.

Customize the Finder toolbar
First, check out which buttons are available in 
the Finder toolbar. By default, you see the Back 
and Forward buttons, the four View buttons, the 
Arrange button, the Action button, the Share 
button, the Edit Tags button, and a Search field.

If you want to thin out the toolbar, you can 
remove any of these buttons. Press and hold the 
Command key, then drag one of the buttons off the 
toolbar. And if you want to rearrange the buttons 
– you may prefer the Search field to be on the left, 
for example – press and hold the Command key 
and drag a button to where you want it.

But you can do a lot more than just move and 
remove buttons. You can add a number of other 
buttons and fields to the Finder toolbar. To see 
these, choose View > Customize Toolbar. You’ll find 
a number of buttons for actions.

To add any of these items to the toolbar, just 
drag and then release them where you want 
them to live. You can move them around, and you 
can add spaces; you’ll see there are two types 
of spaces – a regular, fixed‑width space, and a 
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flexible space that changes its size according to 
the amount of room there is.

Here are a few of the buttons you may or may 
not want to use in the Finder toolbar:

Action: The Action button is part of the default 
button set. It’s the equivalent of the contextual 
menu, which you display by right‑clicking or control 
clicking an item. The Action button’s menu changes 
according to what is selected, offering a range of 
actions you can perform on an item.
View: This button lets you change Finder views. 
However, you may never or rarely want to change 
your windows’ views. If so, you can remove this 
button, saving a lot of space. Just drag it off the 
toolbar and you can still change views from the 
Finder’s View menu or by using keyboard shortcuts.
Share: The Share button lets you quickly share 
items in the Finder, sending them via Mail or 
Messages, or sharing them on Twitter or Facebook, 
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or to other apps or services. You can access this 
feature from the contextual menu (right‑click an 
item and choose Share, then choose a service from 
the submenu), but if you share a lot, it’s good to 
have this button handy.
Edit Tags: If you use Finder tags, you’ll find that this 
button streamlines adding and changing tags.

After you’ve made your choices, click Done. 
Note that from the Show menu at the bottom left 
of the Customize sheet, you can choose to display 
Finder toolbar buttons as Icon Only, Text Only, or 
Icon And Text. Try the different options and choose 
what works best for you.

Quick access to apps, files, and folders
In addition to the stock toolbar buttons, you can 
add any file, folder, or app to the Finder toolbar. 
This gives you quick access to items you use 
often. To add an item to the toolbar, hold down 
the Command key and drag it to the toolbar. You 
can drag it to the exact position where you want 
to use it. When you release the Command key, 
the icon will stay where you want.

This is very useful if there’s an app you want to 
access quickly: it can be quicker to drag a file to 
an app’s icon in the toolbar than, say, dragging a 
file to the Dock, which is further away. Or you may 
have a network volume you connect to regularly; 
just drag its icon to the toolbar, and you’ll be able 
to access it in one click from any window.

Take advantage of the Finder’s flexible toolbar. 
It can make you more productive, giving you quick 
access to the functions you use most.
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 One program you use all the time is the 
Finder. It’s your Mac’s filing system, 
organisational structure, and overseer. We 

all know how to open, move and copy files, but 
most of us go about this without ever considering 
the most efficient way to get these tasks done.

As a prime example, you can use the Finder’s 
View menu options to view files and folders in four 
different ways, but most people don’t know why 

You can save time by learning when to use Icon, List, 
Column, or Cover Flow view Kirk McElhearn explains how

How to: Get the  
most out of Finder views
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they’d bother. They stick to one view for all their 
windows when there are valid reasons to use each. 
Here’s how to use the right view at the right time, 
and save time and trouble in the process.

Flexible Icon View
OS X uses Icon View by default. Select it by 
choosing View > As Icons, pressing Command‑1, 
or clicking on the Icon View button in a Finder 
window’s toolbar. This view shows your files as 
familiar icons.

Some people like Icon View because they can 
arrange file icons as if they were objects on a desk. 
For example, one group of related items on the left 
side of a Finder window, and another on the right. 
Some people don’t like Icon View for the same 
reason; icons can get messy and confusing. They’re 
easy to straighten up, though. Choose View > Clean 
Up and the icons snap into a grid formation.

Icon options
You can not only place icons wherever you please, 
but also change how this view looks. From the 
View Options inspector (View > Show View Options 
or Command‑J), you can, for example, adjust grid 
spacing (how close together icons appear) and 
choose a colour or picture as a folder background.

Another option lets you set, say, a green 
background for folders containing important files, 
and a blue background for folders containing 
documents you need to edit. Just press 
Command‑J, click on Colour (in the Background 
section near the bottom of the View Options 
window), and then click on the colour well. When 
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the colour picker appears, choose your colour and 
click OK. With different backgrounds, you can tell 
multiple windows apart at a glance.

The options you set in the View Options 
inspector apply only to the selected folder, unless 
you select the Use As Defaults option; this applies 
the change to all folders that use the current view 
and that haven’t already been customized in some 
way. (It will also apply to new Finder windows 
you open using File > New Finder Window or 
Command‑N.) This can come in handy when a 
certain option proves useful for only certain types 
of files. For instance, choose the Show Icon Preview 
option to make the Finder display a thumbnail of 
files’ contents (for file types it’s familiar with). Since 
this is most useful for photos and videos – you 
can see their contents at a glance – you can turn 
previews on only for folders that contain them.

Likewise, you might use the Arrange By option 
in different ways depending on a folder’s contents. 
Open your Downloads folder, choose View Options, 
and then select Date Modified from the Arrange 
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By menu to see the most recent files at the top left 
corner of the folder. In a folder containing files you 
want to copy to an external drive, you might choose 
Arrange By Size to see the largest files first, so you 
can choose which ones you can fit on the disk.

Compact List View
If Icon View were the only choice for organizing 
files, many Mac users would be lost. Lots of people 
prefer the more compact List View (View > As List 
or Command‑2). In this view, you see filenames, 
dates (when the files were either modified or 
created), sizes, and more. The View Options 
inspector lets you choose which columns to display.

Since List View is made up of columns, it’s easy 
to change the order your files appear in. Just click 
on a column header to choose an attribute to sort 
by. For example, click on Date Modified to see the 
most recently changed files at the top of the list, 
and click on that header again to change the sort 
order and show the oldest files at the top.

You’ll probably find List View most practical for 
folders that contain lots of files you want to be able 
to sort by name, date, size, or kind. You have the 
option of displaying a preview icon as part of the 
list. List View has two icon sizes; small ones are 
tiny, and large ones are 24 pixels wide. Although 
they can provide an at‑a‑glance way to see what 
types of files you’re dealing with, these icons aren’t 
really big enough to be very helpful.

If you use List View a lot, a better way to see 
file previews is to open a special Info window 
(Command‑Alt‑I). Unlike the Info window that 
displays when you press Command‑I, this window 
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stays visible, changing its display whenever 
you click on a new file. You can see good‑sized 
previews of your images here, as well as play 
music and movie files by clicking on previews. You 
can also open any file, folder, or application by 
double‑clicking on this preview.

One of List View’s biggest advantages is that 
you can open folders and browse their contents in 
the same window. Click on the disclosure triangle 
next to a folder’s name, and the folder’s content 
appears below. You can open and close as many 
folders as you want, and go to as many sublevels 
as you want. To close a folder, just click on the 
disclosure triangle again.

Powerful Column View
I know many people who swear by Column View. 
One Macworld colleague jokingly said to me, “You 
mean there are other views?” Column View (View 
> As Columns or Command‑3) shows your files 
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within their hierarchy; you see the folders and files 
above and below your current folder, each level in 
a separate column. This makes it easy to move files 
without having to open multiple Finder windows. 
Just drag a file from one spot to another in the 
hierarchy. So Column View is helpful, for example, 
when you need to zip up and down your Mac’s 
hierarchy to find specific files and move or copy 
them to other locations.

However, this view can get confusing, especially 
because when you click on a folder, the Finder 
may shift all of the window’s columns to display its 
contents. You may have to scroll back and forth 
horizontally to keep track of things.

You can arrange files according to name, date, 
size, and so on in Column View by choosing these 
options from the View Options window, but only the 
items’ names are displayed. So Column View is not 
useful when you need more information than just 
names. However, you can choose to see a useful 
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preview column, which shows a large thumbnail 
of the selected item. And here you can preview 
photos and videos along with all the file information 
List View provides, such as size, creation and 
modification dates, and more.

Taming Column View
Column View can be tricky. For example, it can be 
hard to figure out how to make new folders appear 
w\here you want. This is just a question of being 
in the proper column. Make sure you click on an 
item (not a folder) in a column before pressing 
Command‑Shift‑N to make a new folder in that 
column. If you click on a folder, the new folder will 
appear inside the selected folder.

If you have trouble with filenames getting cut 
off in columns, there are a few quick ways to make 
them legible. Resize a single column by dragging 
the very bottom of one of the column dividers until 
you can see the longest filename. Alternatively, 
double‑click on the divider to make it that size 
automatically. You can Option‑double‑click to 
make all columns as wide as the widest column in 
the Finder window, but this can make the window 
unmanageably huge. It’s usually better to resize 
all the columns at the same time by pressing and 
holding the Option key while you drag.

When you use Column View in an Open or 
Save dialog box, you have one more way to do 
this. Control‑click on the column divider icon 
(at the bottom of the divider), and you’ll see a 
contextual menu. Choose from Right Size This 
Column, Right Size All Columns Individually, or 
Right Size All Columns Equally.
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Quick and pretty Cover Flow View
Cover Flow View gives you a different way to 
view your files. Choose View > As Cover Flow or 
press Command‑4 to view your files and folders as 
graphics in the top section of a window; the same 
files are shown in a list in the window’s bottom 
section. (You can’t change that bottom section’s 
appearance.) Cover Flow is not very useful for 
everyday file management because it limits the 
number of files you can see at a time.

That said, Cover Flow View is great when you 
need to sift through a folder of photos, videos, or 
even text files, as long as OS X can display the 
contents of those files. If you increase the size of 
your window, Cover Flow View can display huge 
previews. This is helpful, for example, when you 
need to find a Word document or a Numbers 
spreadsheet with specific content at the beginning. 
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(No matter how big the preview is, Cover Flow 
displays only the document’s first page.)

See more with Quick Look
All four views can display some kind of preview, but 
nothing compares with Quick Look. Use it in any 
view by selecting a file and pressing the spacebar. 
If the Finder can read the file type, a Quick Look 
window pops open and displays the file’s contents. 
You don’t have to wait for an app to load or the file 
to open, which means that you save a lot of time 
when you just want to glance at some files to find 
the one you’re looking for.

Quick Look can be more or less interactive 
for different types of files. For Apple Numbers 
and Microsoft Excel workbooks, you can click on 
worksheets to see their contents. You can scroll 
through Microsoft Word documents and Apple 
Keynote presentations, and you can click on links 
in HTML pages. Have a folder full of files you 
want to examine closely but quickly? Select the 
files and then press the spacebar.

You’ll see a number of tools displayed on the 
Quick Look window. With some files, such as PDFs, 
Word files, Pages files, and so on, you’ll be able 
to view thumbnails of the files’ pages. If you’ve 
selected multiple files, click on the Previous and 
Next arrows to move through your files. Click on 
the Index Sheet button to see all the files’ previews 
at once, or click the Full Screen double‑arrow 
button to make the preview fill your screen. If you 
decide that you want to preview a different file, 
don’t close the Quick Look window; rather, just 
click on a different file. The Quick Look window 
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will update to show the selected item. And click 
the Open With button at the top of the window 
to open the file with its default app. There’s also 
a share button at the top right that lets you send 
it to a friend by email or Messages, share it on 
Facebook or Twitter, and more.

One disadvantage of Quick Look is that its 
floating window appears only when you’re in 
the Finder. If you switch to another program, it 
disappears. It doesn’t close, though; just switch 
back to the Finder to see it again. Press the 
spacebar to dismiss it.

Increase your knowledge of Finder
You spend a lot of time in the Finder, so learning 
about its many possibilities can save you time and 
give you more power over your files and folders. 
Mastering Finder views is one of the first steps to 
becoming a Mac power user.
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 Long‑time Mac users remember how software 
was distributed before the introduction of the 
Mac App Store. You could buy boxed software 

in retail stores, and you could download shareware 
that you could try out and pay for if you liked. There 
was also freeware. Some developers still practice 
the shareware model, but the Mac App Store has 
become the sole provider for much of the software 
people use on their Macs.

The Mac App Store has become the sole provider  
for much of the software people use on their Macs. 

Kirk McElhearn argues  that it needs to do more

Opinion: Mac App Store 
needs to support demos
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This has its advantages: users are protected, 
since Apple validates the software; they don’t have 
to trust their credit card numbers to potentially 
dodgy websites; and it’s easy to redownload apps 
and get updates, all through a single app that 
serves as a storefront. Developers pay Apple a 30 
percent commission, but Apple manages fulfilment 
and billing, and exposes their software to tens of 
millions of Mac users, so it’s not a bad deal.

But two things are missing from the Mac App 
Store: demo versions and paid upgrades. (This also 
applies to the iOS App Store, but I’ll just focus on 
the Mac here.) You can’t download an app to try it 
out for a week or a month, and then pay for it if it 
suits your needs. And you can’t get a discount on 
an upgrade to an app you bought a year or two 
ago, or even last week.

Both of these features are essential. Few users 
buy apps that cost £7, £15 or even £30 (or more) on 
the Mac App Store unless they’re sure those apps 
work exactly as they expect. I’ve downloaded many 
app demos only to find in the first minutes that the 
app isn’t for me. The Mac App Store could easily 
offer time‑limited demos so users can test them out. 
These demos don’t need to be long for most apps; 
a week is probably fine for basic apps, a month for 
apps with more complex features. Since the Mac 
App Store uses DRM, it would be trivial for Apple to 
develop a system whereby the apps stop working 
after a certain time.

Some developers do offer demos of their 
apps, but Apple won’t let them say so in their app 
descriptions on the Mac App Store. Users have to 
know that by checking an app’s web page they 
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might find a demo. For example, Flexibits offers a 
21‑day demo of the calendar app Fantastical.

Some developers use a workaround to provide 
demos: they sell a free app with in‑app purchases. 
I find this confusing. If I later redownload an app, I 
may forget that I’ve bought these IAPs and which 
features they offer. I’d rather see the full price up 
front, and not be tricked by ‘Free’.

Upgrade pricing ensures that users remain 
faithful to an app; developers want to reward 
customers who have been using their calendar, 
text editor, or game, and to retain these customers 
over time. Upgrades also ensure that users are 
aware of new versions. When a developer releases 
a new version of an app, they can’t let existing 
users know there’s an upgrade via the Mac App 
Store. They have to name the upgrade differently: 
instead of MyApp having a new version number, the 
app’s name has to be MyApp 2. Some developers 
discount upgrades on launch (for a week or two, 
usually), which allows existing users to get a lower 
price, but also means that new users get ‘upgrade’ 
pricing. However, if an existing user misses the 
launch window, they have to later pay full price.

These features are essential to a healthy app 
ecosystem, and without them, both users and 
developers lose out. Users won’t take chances 
on new, unfamiliar apps, and developers can’t 
maintain a stable, long‑term user base. Third‑
party apps are one of the key elements of the 
Mac platform, and the more apps people buy, the 
more likely they are to stick with the Mac. Adding 
demo versions and upgrades would be beneficial 
for users, developers, and Apple.
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